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ABSTRACT 

When doing finite element analysis upon the structure of Saab’s aircrafts a coarse global model of 
mainly shell elements is used to determine the load distribution for sizing the structure. At some 
parts of the aircraft it is, however, desirable to implement a more detailed analysis. These areas are 
usually modelled with solid elements; the problem of connecting the fine local solid elements to the 
coarse global model with shell elements then arises. 
 
This master thesis is preformed to investigate possible Global-Local methods to use for the 
structural analysis on Gripen, on of the latest generations of Saabs aircrafts. First a literature study 
of current methods on the market is made, thereafter a few methods are implemented on a generic 
test structure and later on also tested on a real detail of Gripen VU. The methods tested in this thesis 
are Mesh refinement in HyperWorks, RBE3 in HyperWorks, Glue in MSC Patran/Nastran and 
DMIG in MSC Nastran. The software is however not evaluated in this thesis, and a further 
investigation is recommended to find the most fitting software for this purpose. All analysis are 
performed with linear assumptions. 
 
Mesh refinement is an integrated technique where the elements are gradually decreasing in size. Per 
definition, this technique cannot handle gaps, but it has almost identical results to the fine reference 
model. 
RBE3 is a type of rigid body element with zero stiffness, and is used as an interface element. RBE3 
is possible to use for both Shell-To-Shell and Shell-To-Solid couplings, and can handle offsets and 
gaps in the boundary between the global and local model. 
 
Glue is a contact definition and is also available in other software under other names. The global 
and the local model is defined as contact bodies and a contact table is used to control the coupling. 
Glue works for both Shell-To-Shell and Shell-To-Solid couplings, but has problems dealing with 
offsets and gaps in the boundary between the global and local model. 
 
DMIG is a superelement technique where the global model is divided into smaller sub-models 
which are mathematically connected. DMIG is only possible to use when the nodes on the boundary 
of the local model have the same position as the nodes at the boundary of the global model. Thus, it 
is not possible to only use DMIG as a Global-Local method, but can advantageously be combined 
with other methods. 
 
The results indicate that the preferable method to use for Global-Local analysis is RBE3. To 
decrease the size of the files and demand for computational power, RBE3 can be combined with a 
superelement technique, for example DMIG.  
 
Finally, it is important to consider the size of the local model. There will inevitably be boundary 
effect when performing a Global-Local analysis of the suggested type, and it is therefore important 
to make the local model big enough so that the boundary effects have faded before reaching the area 
of interest. 
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CHAPTER 1  
INTRODUCTION 

 
 
This chapter is an introduction to the thesis, describing the background, purpose and method for the 
project. 
 

1.1 Saab 
Saab, Svenska Aeroplan Aktiebolaget, was founded in 1937 after a decision of the Swedish 
government to enlarge the domestic military aircraft industry in Sweden. Since Saab delivered its 
first aircraft, the light bomber and reconnaissance aircraft B 17, they have had a close cooperation 
with the Swedish Air Force and have developed several generations of military aircrafts, such as 
Tunnan, Lansen, Draken, Viggen and Gripen 
 
Jas 39 Gripen, hereafter Gripen, is a multi-role fighter used for fighter, attack and reconnaissance 
missions. There are four different versions of Gripen of which two are two-seaters. A completely 
new version of Gripen, under the working name Gripen VU, is now being developed. 
 
Saab is today one of the worlds leading companies in the defence industry with around 12 500 
employees and is divided into five business areas, active mostly in Europe, South Africa, Australia 
and the United states. For further details, see Saabgroup, 2010. 
 

1.2 Objective 
A common technique to evaluate the strength of a complex body, such as an aircraft, is to perform a 
finite element analysis. It is not a technique that can completely replace the physical testing, 
nevertheless, it is used as much as possible, within what the regulations allow, because of the 
economical advantages. The finite element method is a numerical simulation techniques and is used 
in a wide variety of disciplines such as examination of cracks, thermal heating and flutter. The 
analyses of an aircraft are based on the worst case scenario, for example doing a tough manoeuvre 
in bad weather. 
 
When doing finite element analysis upon Saab’s aircrafts a global model is used to determine the 
load distribution for sizing the structure. The global model has a coarse mesh, precluding details in 
the structure to reduce the computational power and shorten the calculation time. At some parts of 
the aircraft it is however desirable to implement a more detailed analysis, for instance at 
attachments where the loads can be locally high and therefore damage the structure. 
 
During the procedure of connecting the local and global models different types of challenges can 
occur, for example; the nodes of the two different shell element models can be inconsistent or the 
dimensions of elements can differ between the global and local model. There are today several 
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methods in different software to deal with Global-Local analysis, and the aim with this master thesis 
is to investigate how these methods work and which methods could be suitable for Saab’s Global-
Local analyses on Gripen. This thesis is not intended to evaluate different software, although a few 
specific programs have been used in this study. Many of the methods are also available in other 
software and it is recommended to do a further investigation if the most fitting software for each 
method is needed. 
 

1.2.1 The Global Model of Gripen 
The global finite element model of Jas 39 Gripen consists mainly of shell elements with beam 
elements as stiffeners. The shell elements are two-dimensional elements with a surface, thickness 
and material data such as stiffness and mass, whereas the beam elements are one-dimensional 
elements that are subjected to traverse and normal load as well as moments.  The nodes in the shell 
elements have six degrees of freedom, translation and rotation in each direction. Other element 
types that are used in the global model are solid elements for thick sandwich cores, point elements, 
for mass loads, and spring elements. 
 
The global model has to give a true interpretation of stiffness and mass. Furthermore, it is also used 
in other disciplines such as calculations of linear dynamic loads, flutter and aero servo elasticity 
analysis. 
 

1.2.2 The Local Models of Gripen 
The local models consist mainly of either shell or solid elements, where solid elements only have 
three, translational, degrees of freedom. 
 
A local model is for example needed at details including radius with high stress concentrations or 
details where the geometry is complex. The local model can also be used to implement non-linear 
calculations, for example when non-linear material properties are needed, or when the geometry is 
offset. 
 

1.3 Procedure 
The thesis start with a thorough literature study of the methods on the market, examples of 
questions that require answers are following: 
 

Which methods exist today? 
Which methods can be implemented in the software used by Saab? 
How are other companies in the aerospace industry solving this problem? 

 

 

Figure 1.1: Flowchart over the procedure 

 

Literature 
study 

Parametric 
study 

Gripen 
model 

Evaluation 
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The literature study is followed by a parametric study where some of the methods found in the first 
step are tested on a generic model. The parametric study will lead to a few preferred methods that 
are to be applied on a test model from Gripen VU to evaluate the feasibility and effectiveness. A 
flowchart over the procedure is seen in Figure 1.1. 
 

1.4 Software 
Finite element software are built in three parts; a pre-processor in which for example the geometry 
and mesh can be defined, a solver that is performing the calculations, and a post-processor where 
the results from the solver ca be displayed in a variety of ways, such as plots and graphs. The 
process is described in Figure 1.2. 
 

 

Figure 1.2: Structure of Finite Element software 

 
The pre-processor generates a file with bulk-data, containing all information about the model, mesh, 
loads etc. This bulk-data file is then sent to a solver. The solver generates for instance a MASTER 
and DBALL file during the solving process; however these files are usually deleted after solving 
and replaced by an input file to the post-processor. 
 
The software to be used for this master thesis is not fixed. However, as a pre-processor, HyperMesh 
or MSC Patran is preferred at Saab and MSC Nastran is preferred as a solver of linear calculations 
and some nonlinear calculations. Abaqus is usually used for the nonlinear calculations. Post-
processing is usually done in the in-house tools DIM and Intplot.  
 
MSC Patran and MSC Nastran are used for the structure analysis of Gripen today, and one of the 
secondary objectives of this master thesis is to investigate whether the HyperWorks package can be 
used instead. Due to this, MSC Patran, MSC Nastran and the HyperWorks package will be used in 
this master thesis. The different software combinations are not mixed; when MSC Patran is used as 
the pre-processor, MSC Nastran is always used as a solver. In the same way; RADIOSS is always 
used as a solver when the model is constructed in HyperMesh. 

Pre-processor 
e.g. Patran, HyperMesh 

MASTER 

DBALL 

Bulk-data 

xdb 

op2 

Solver 
e.g. Nastran, Radioss 

Post-processor 
e.g. Patran, Inplot, DIM 
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For evaluation and comparison of the results in the parametric study, MATLAB is used. 
 

1.5 Restrictions 
The thesis shall result in a proposal of one or more suitable methods for Global-Local finite element 
analysis. Since the displacement and force approaches (multiscale analysis) already have been 
tested for Gripen, this thesis will have a main focus on integrated analysis and superelements. The 
multiscale analysis is however still a part of the literature study. The chosen method have to be 
effective in that way that it must solve the problem as correctly as possible but still be feasible in 
terms of software, time and money. 
 
The global model of Gripen is modelled in MSC Patran, which means that if an integrated model is 
to be used, the pre-processor is restricted to MSC Patran unless the global model is exported to 
another software. A break out model or the superelement approach could however be implemented 
in an optional program if this procedure is believed to bee advantageous. 
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CHAPTER 2  
THEORY 

 
 
This chapter describes the basic technique behind Finite Element Analysis in general and Global-
Local methods in particular. For more information about each Global-Local technique used in this 
master thesis, the reader is referred to Appendix D User Guide to Used Methods. 
 

2.1 Fundamentals of Finite Element Analysis 
The Finite Element Method (FEM) is today a widely spread computational technique among 
engineers used to calculate approximate solutions in a large variety of engineering disciplines. 
According to Torstenfelt, 2008, the history of the method can be traced back to Richard Courant in 
1942. As the computer became more common and increasingly better, the method became a more 
sophisticated method and the word “finite element” was coined by Ray W. Clough in 1960. One of 
the main driving forces for the development was engineers working in the aeronautical industry and 
in the 1970s the first commercial finite element package was developed. 
 
Finite element method can be used to solve both partial differential equations and integral equations 
by either eliminate the differential equation completely or replace it with an ordinary differential 
equation, which can be solved. The domain is usually a physical structure divided into finite 
elements with a resulting model called mesh. The variables of interest are computed at the corner 
points of the elements, which are called nodes. Each node has a given set of degrees of freedom, 
which is all possible ways the node can move; for example translation or rotation in different 
coordinate directions. 
 
In finite element analysis, different types of elements are used, where the elements have various 
dimensions and shapes depending on what properties that are desired, for further information, the 
reader is referred to Felippa, 2004. Figure 2.1 shows some of the most commonly used element 
types. 
 
Zero-dimensional elements are point entities that represent for example a point mass. 
 
One-dimensional elements have a length but no area, it is placed between two nodes and can 
sometimes also have middle nodes as well. Unlike the zero-dimensional element this element can 
contain material properties, such as density, Young’s modulus, Poisons ratio and geometry features 
like cross section area and second moments of inertia. The one-dimensional element can be for 
example a beam or bar. 
 
Two-dimensional elements have a surface and contain material properties as well as geometrical 
ones like thickness. The nodes in the two-dimensional element may have up to six degrees of 
freedom, translation and rotation in each direction. There are various shapes but the most common 
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are quadrilateral and triangular elements. The two-dimensional element can be for example a plate 
or a shell. 
 
Three-dimensional elements have unlike the two-dimensional elements also a volume. It can 
contain material properties and the nodes have three, translational, degrees of freedom. The most 
common shapes are tetrahedral and hexahedral element. 

 

Figure 2.1: Visualization of the different element types and dimensions 

 
A general rule to obtain a more accurate solution is to increase the number of elements used. The 
increase of elements is however also affecting the computational needs; according to Kxcad, 2009, 
the time taken for a matrix solution is proportional to the square of the total number of degrees of 
freedom of the structure.To overcome this problem, the structure can be divided into sections where 
Global-Local modelling may be used. 
 
As described in the introduction, when doing finite element analysis upon Gripen, a global model 
with a coarse mesh is used. The global model is then divided into other local models with a more 
dense mesh. There are today several different methods to connect the local models to the global 
models. Figure 2.2 shows a breakdown chart over the classification of methods treated in this 
report. 
 
The local model can be analyzed as a breakout model physically separated from the global model 
(multiscale analysis, also called break out modelling) or physically attached to the global model 
(integrated analysis). A mixture of this two are the Direct Matrix Input approach, where the local 
model is physically separated from the model but mathematically attached. All methods are 
explained more thorough below in this section. 
 
The advantages of using superelement, also called sub-structure technique, are mainly three; to be 
able to divide the labour in an effective way, to take advantage of the fact that the structures often 
are built of several identically units and also to overcome computer limitations. 
 

1D 

2D 

3D 

0D 
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Figure 2.2: Breakdown chart over Global-Local finite element methods 

 

2.2 Multiscale Analysis 
The structures modelled in the aircraft industry are usually of a quite complicated art and the 
multiscale analysis is therefore a commonly used method in the industry. The essential view of the 
multiscale analysis is to divide the structure in sub-models which can be edited and simulated 
parallel to each other. The aircraft is first modelled as a global model with a coarse mesh excluding 
local details, and is then divided into smaller local models where the mesh usually is finer to give 
more detailed results.  
 
The multiscale analysis originates from Saint Venant’s principle published in 1855, and later on 
interpreted by for example von Mises in 1945. The core of the Saint Venant’s principle is that the 
difference between stresses caused by statically equivalent loads becomes very small at sufficiently 
large distance from the load. That is, if the boundary is placed at a sufficiently large distance from 
the area of interest in the local model, the results will not be affected by the absence of the global 
model. Tests have shown that the boundary effects are insignificant at a distance greater than the 
largest dimension of the area over which the loads are acting. This is described by Molker, 2012. 
 
There are two main ways to execute the multiscale analysis; the displacement approach and the 
force approach. Commonly to both methods is that boundary conditions between the global and 
local models are extracted from the global model and used as boundary conditions in the local 
model. A mixture of the two methods can also be used; a combination of displacements and forces 
from the global analysis is then extracted as boundary conditions from the global model. This 
approach is possible to use if the local sub-model is transferring forces in a well defined load path, 
se Raghavan, Prasanna Kumar, 2008, for further details. 
 
To make sure that the multiscale analysis is accurate a coupled approach can be used. That is, after 
performing the analysis, the boundary conditions from the local model are transferred to the global 
model where a new analysis is performed to check if the global model is affected. 
 
There are several ways of extracting the values at the boundary from the global model, one is to use 
fields in for example MSC Nastran and another one is to use free body diagram which is available 
in several software such as MSC Patran and HyperWorks. Free body diagram is a tool in the pre-
processor where forces and moments on the boundary to the local model are extracted. This result 
can be extracted and implemented as boundary conditions to the local model. 

Global-Local 
FE-Analysis 
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Displacement 
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2.2.1 Displacement Approach 
The most common of the multiscale analyses is the displacement approach when displacements are 
extracted from the global model and used as boundary conditions in the local model, described by 
Raghavan, 2009. This method is very effective but it has two important limitations. Firstly, the 
geometry and material properties of the global- and local models have to be the same. 
 

2.2.2 Force Approach 
The second approach to perform a multiscale analysis is to use forces and moments as boundary 
conditions. With this approach, the shortcomings for the displacement method are overcome. The 
force method gives the local sub-model as a free body diagram, where the forces acting on the sub-
model are in self equilibrium.  
 

2.3 Integrated Analysis 
To be able to perform optimization on a local detail it is required to simulate the local model within 
the global model, in these cases an integrated analysis is used. The integrated analysis could be 
divided into three subgroups, depending on the element types in the global and local model. 
 
In Gripen, the global model is built of mainly shell elements, whereas the local models usually 
consist of mainly solid elements. This is obviously an issue since the different models have nodes 
with inconsistent degrees of freedom. If the differences in degrees of freedom are not taken into 
account, the transition will act as a hinge for plate elements or as a pinned connection for bar 
elements. 
 
When integrated analysis is used, there could be incompatibilities between elements which can 
result in local stress deviations. Due to this it is important never to place the boundary between the 
global and local model in or near an area of interest or where the stress variations are large. The 
area of interest will, however, not be affected if the interface elements are placed far enough apart, 
according to Saint Venant’s principle, see Von Mises, 1945, for further details. 
 

2.3.1 Mesh Refinement 
Mesh refinement is a method that can be used when the global and local model is of the same 
dimensions, Shell-To-Shell or Solid-To-Solid. When using mesh refinement the density of the 
coarse global mesh is enhanced. There are three kinds of refinement methods described by Flaherty. 
 

h-refinement: local refinement of a mesh 
r-refinement: relocating or moving a mesh 
p-refinement: varying the polynomial degree of the basis 

 
An example of a mesh refinement is the use of triangular elements as in Figure 2.3. A theoretical 
alternative to the triangular elements is to delete mid-side nodes; this is however usually a non-
advantageous method since it distorts the stress distribution in the elements. If triangular elements 
are used, it is important to never use the results of these elements because they have increased 
stiffness. A few triangular elements spread out in the model could however be okay as long as they 
are not placed in the area of interest.  
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Figure 2.3: Example of triangular refinement elements 

 

2.3.2 Interface Elements 
One alternative to mesh refinement is to us interface elements. The interface method is however 
also working when the elements in the global and local models are of different dimensions. The 
interface element makes the displacement of the nodes in the local model slaved to nodes in the 
global model with multipoint constraints, described below. An example of the principal of interface 
elements is showed in Figure 2.4 where the middle node in the local model is slaved to the two 
nodes in the global model. The displacement is interpolated between the two global nods to receive 
the displacement in the local node. More information about interface elements can be found in MSC 
Software Corporation, 2012a. 
 

 

Figure 2.4: Principal of interface element. The displacement of the middle node in the local model 
is extracted from the two nodes in the global model by interpolation. 

 

2.3.3 Rigid Elements 
When a local model, with solid elements, are to be connected to a global model consisting of shell 
elements it is possible to either add an additional plate or bar to shell element that continues into the 
solid element or to use an interface element for the transition. One example of such element is a 
Ridged Body Element (RBE) also called constraint element, the rotations is then slaved to the 
translations of the adjacent grid points on the solid element with MPC equations described below. 
The RBE generally has infinite stiffness, according to Cook, 1989,  it is always better to make the 
element perfectly rigid rather than very stiff to avoid ill-conditioning errors. RBE can also be used 
to connect two shell elements. RBE is not bound to one specific software, but is available for most 
of the commercial software. 
 
RBE3 belongs to the RBE-family, despite the name, the RBE3 is not rigid, it has zero stiffness and 
is really an interface element, RBE3 uses weighting factors between the slaves and master nodes to 
calculate the movement and force distribution. RBE3 in Nastran is basically a manual method 
where the user has to define which nodes should be connected to each other. In HyperWorks there 
is a script available that automatically defines RBE3 from given sets of nodes. This approach could 
be a feasible way in MSC Nastran as well, however in MSC Natstran there is a special type of rigid 
element called RSSCON developed specially for Shell-To-Solid couplings. The RSSCON works 
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optimal if the thickness of the shell, t, is equal to the height of the solid, h, see Figure 2.5. If the 
solid is larger than the shell thickness, the transition will be much stiffer than the continuum model. 
For further details, the reader is referred to MSC Software Corporation, 2012a. 
 

 

Figure 2.5: Optimum dimensions for RSSCON coupling 

 

2.3.4 Multipoint Constraints 
Multipoint constraints (MPC), described in detail by Felippa, 2004, is a method when different 
nodes and degrees of freedom are connected together, in a master and slave behaviour. In other 
words, the displacement of the slave node is forced to follow the master node. The chosen slave 
displacement is eliminated from the degrees of freedom.  
 
Multipoint constraints can be used manually, with interface elements as described for RBE above, 
or in other automatic techniques where the user defines two areas to be connected and the pre-
processor defines the multipoint constraints between the nodes on the two areas. 
 

2.3.5 Glue Constraint 
Glue constraint is an automated technique using multipoint constrains to merge two surfaces 
together, by defining them as contact surfaces. It is a technique available in several software under 
different names, see Table 2.1 for some examples. The technique will be addressed as Glue further 
on in this thesis.  
 

Table 2.1: Glue constraint in different software 

Compatible with… 
Software Name …edge contact (Global-

Local analysis) …surface contact 

MSC Patran/Nastran Glue Yes Yes 
Abaqus Tie Yes Yes 
HyperWorks Freeze contact No Yes 

 

t 

h 

Solid elements Shell element 

h = t 
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This constraint fuses two regions together, even though the meshes created on the surfaces may be 
dissimilar. The constraint is creating an interface without any relative motion between the surfaces 
which can be deformable or rigid. Glue and Tie are both available to use between two shells as well 
as between a shell and a solid and two solids. At the time of writing, Freeze contact in HyperWorks 
only works as surface contact. For further information, the reader is referred to MSC Software 
Corporation, 2012a and Abaqus, 2007. 
 
A tolerance region between the connecting nodes is automatically created around the master surface 
or master node, depending on the dimension of the master region. According to MSC Software 
Corporation, 2012b, the tolerance region is defined normal to the contact section. It also has a bias 
factor giving a smaller distance on the outside surface than on the inside, see Figure 2.6. The 
tolerance region specifies the accepted position for the slave surface, if a node is not included in the 
within the tolerance region, it will remain unconstrained and can therefore move freely and 
penetrate the master surface. If there is no initial contact, it is possible to define that the gap 
between the two regions should remain constant. 

 

Figure 2.6: Definition of Bias and Tolerance region for a surface 

 

2.3.6 Shell-To-Solid Coupling in Abaqus 
As a complement to the Tie constraints, Abaqus has an automated Shell-To-Solid coupling, see 
Abaqus, 2007. This coupling formulation assumes that the interface surface between the shell and 
solid elements is normal to the shell, since the local model with solid elements could be curved, it is 
important to place the global surface elements straight in the direction along the shell normal. It is 
also preferred to place the surface centrally located on the solid respect to the thickness.  
 
The Shell-To-Solid Coupling works when wanting to connect the edges of two regions, however the 
element size must be approximately the same which means that this has to be combined with 
another method to use in Global-Local analysis. This technique will not be handled further in this 
master thesis, due to that Abaqus is not used for the global model of Gripen today but is included in 
the literature study for use in the future, for example when performing non-linear analysis. 
 

2.4 Superelements 
A superelement is a group of elements that for computational purposes can be regarded as one 
individual element. The technique was invented in the aerospace industry in the 1960s to simplify 
the calculations upon a complex structure using the divide and conquer approach. The theory behind 
the superelement technique is described in detail by Felippa, 2004. 
 
Superelements can be used in multiple levels, in other words, one superelement can in turn consist 
of other superelements. 
 

 
(1-Bias)*Tolerance 

 
(1+Bias)*Tolerance 
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2.4.1 Static Condensation 
Static condensation technique, also called Guyan reduction, is a technique based on that internal 
degrees of freedom of the superelement are eliminated. It is a preferred technique for sub-
structuring with superelements when the local model is most likely going to be modified, with 
respect to thickness increments, local reinforcement’s etcetera. Unlike the multipoint constraint, 
static condensation is based on equilibrium constraints, which involve displacements indirectly, the 
multipoint constrain deals with the displacements directly. 
 
The total amount of degrees of freedom (DOF) for a superelement can be divided according to 
Figure 2.7. The total number of DOF is denoted g, for shell elements this is 6 multiplied by the 
number of nodes, for solid elements 3 multiplied by the number of nodes etc. The total DOF is then 
divided into constrained DOF c and free DOF f. The free DOF are either masters m or slaves s. See 
Martínez, 2000, for further details. 
 

 

Figure 2.7: Subdivision of degrees of freedom 

 

2.4.2 Direct Matrix Input 
Direct Matrix Input is a superelement technique with static condensation in MSC Nastran, described 
in MSC Software Corporation, 2012a. When using the Direct Matrix Input in MSC Nastran 
(DMIG) the boundaries between the global and local models are simulated with mathematical 
equations written in matrix format. In this way, it is not necessary to simulate the entire global 
model since they are still connected by the mathematical equations. Depending on what is 
prioritized the matrices are read in different ways, there are stiffness, mass and load matrices 
available. The stiffness matrix is the most commonly used and is formulated using static 
condensation to reduce the stiffness to the boundary between the global and local model. 
 
The nodes in the global and local model must fit together; therefore it is not possible to use DMIG 
as an independent solution to Global-Local modelling with inconsistent meshing, but can be 
combined with another method to be used in Global-Local analysis. Since DMIG provides the 
opportunity to optimize and perform non-linear analysis it could nevertheless be an advantageous 
method. 

m…master 

s…slave 

f…free 

c…constrained 

g…total degrees of freedom 
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CHAPTER 3  
GENERIC MODEL AND EVALUATION 

CRITERIA 
 

 
Some of the techniques described in Chapter 2 are implemented on a simple generic model. This 
chapter describes the generic model that is used and the different sub-cases of local models and 
load cases applied to the model. The evaluation criteria for the evaluation of the results are 
described here as well. 
 

3.1 The Global Model 
The generic model used to test the Global-Local techniques is designed to resemble a typical wall 
with stiffening beams. The dimensions are defined after consideration with staff at Saab. The main 
purpose with the design is to have a simple model to test the Global-Local methods on. 
  
The original global model consists of two-dimensional shell elements of first order and one-
dimensional bar elements, also of first order, used as stiffeners. A 3D representation of the generic 
model is shown in Figure 3.1. However; note that the figure is only a representation and does not 
show the true dimensions, see Figure 3.2 and Figure 3.3 for dimensions of the global model and 
beams. The global coordinate system is defined with origin in the lower left corner. 

 

Figure 3.1: 3D representation of the global generic model. Does not show the true dimensions 
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The width of the global generic model is 100 mm, height 100 mm and the thickness of the shell 
elements is 2 mm. As seen in Figure 3.1, the global model consists of 6 times 6 elements, however 
the element size of the shell element is not uniform; the standard size is 20 times 20 mm whereas 
the side centred regions are split into two equally sized elements and the central region is split into 4 
equally sized elements. The four central elements are later replaced by the local model. The 
dimensions of the global model are seen in Figure 3.2. 
 

 

Figure 3.2: Dimensions and coordinate system of the global generic model. Beams are represented 
with thick lines. Dimensions in mm 

 
The beams are placed on the boundary of the plate and 20 mm from the boundary parallel to it. The 
beams are T-shaped with dimensions according to Figure 3.3. The properties for the beams are 
stated in Table 3.1, the material is the same as for the shell elements described in Table 3.2. 
 

 

Figure 3.3: Dimensions of the beams used in the global model. Dimensions in mm 
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Table 3.1: Beam properties for generic model 

Property  Value Unit 

Area A 16 mm2 
Inertia 1,1 Iy 22.8 mm4 

Inertia 1,2 Ix 31.3 mm4 
 

3.1.1 Material 
The entire global model is built of aluminium, which is a commonly used material for aircrafts. It is 
defined as a linear elastic and isotropic material with properties stated in Table 3.2. The same 
material data is used for all local models. 
 

Table 3.2: Material properties of aluminium for the generic model 

Property  Value Unit 

Elastic Modulus E 71800 MPa 

Poissons ratio  0.33 - 

Shear Modulus G 27000 MPa 
 

3.2 The Local Models 
The four central elements in the global model are replaced by a local model with a more refined 
mesh. To test the ability of the different Global-Local modelling techniques, different types of local 
models are used. Since the mesh of the local model in a real case scenario almost never is in contact 
with the global models at all nodes, some test cases are preformed where gaps and offset are 
present. 
 
All local models are built of aluminium, with same material properties as in the global model. A 
summary of all cases of local models is found in Table 3.3. 
 

Table 3.3: Summary of local model cases. *Number of element and the element sizes for case 3 and 
4 is different for different sub-cases, see respectively section for more information 

Case no Element type Number of Elements Element size [mm] Offset 

1 Shell 100 2*2 No 
2 Solid 100 2*2*2 No 
3 Shell 100 or 90* 2*2* Yes 
4 Solid 100 or 90* 2*2*2* Yes 

 
Case 1 and 2 test the methods for compatible geometry with shell and solid elements respectively, 
and case 3 and 4 test the methods when the geometry have offsets and gaps with shell and solid 
elements respectively.. 
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3.2.1 Case 1: Shell Elements 
The first and most basic local model consists of 10 times 10 shell elements that each has a width of 
2 mm, height of 2 mm and a thickness of 2 mm. The outer corner nodes and side-centred nodes are 
equivalent to the nodes in the global model. The local model is illustrated in Figure 3.4. 

 

Figure 3.4: Local model (green) for Case 1, consisting of 100 shell elements 

 

3.2.2 Case 2: Solid Elements 
The second local model has the same number of elements as in case 1, but here they are solid 
elements with the same dimension as before. The local model for Case 2 is shown in Figure 3.5. 
The solid elements are centred on shell elements, meaning that 1 mm is above the mean surface of 
the shell elements and 1 mm is below.  

 

Figure 3.5: Local model (green) for Case 2, consisting of 100 solid elements 
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3.2.3 Case 3: Offset With Shell Elements 
Case 3 is divided into several sub-cases, testing how the method can deal with offsets and non-
cohesive geometry. All sub-cases are summarized in Table 3.4 and they are all based on the 
geometry from case 1. The local model consists of shell elements. 
 

Table 3.4: Summary of sub-cases for offset with shell elements 

Number of elements Gap relative global model [mm] 
Case no Element size 

[mm] x y z x=40 x=60 y=40 y=60 z=0 

3a Uniform 2.2 9 10 - 0 2 0 0 0 
3b Uniform 2.2 9 10 - 1 1 0 0 0 
3c Uniform 2.2 10 10 - 0 0 0 0 0.1 
3d Variable 10 10 - 0 0-1.9 0 0 0 
3e Variable 10 10 - 0 0.1 0 0 0 
3f Variable 10 10 - 0 0.01 0 0 0 
3g Variable 10 10 - 0 0.001 0 0 0 

 
In Cases a-b 10 elements are removed of the local model, see Figure 3.6 and Figure 3.7. Case c only 
has an offset in z-direction, see Figure 3.8. Cases d-g all have 100 element but with variable sizes; 
in Case d, the 10 elements along the right side are transformed according to Figure 3.9, and in Cases 
e-f are the outer nodes along the right side moved in negative x-direction according to distances 
stated in Table 3.4, see Figure 3.10. 
 

 
Figure 3.6: Geometry for local generic model (green) for Case 3a (shell elements) and 4a (solid 

elements). The gap, on the right side of the local model is 2 mm 
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Figure 3.7: Geometry for local generic model (green) for Case 3b (shell elements) and 4b (solid 
elements). The gap to the global model is 1 mm on both left and right side 

 

 
Figure 3.8: Geometry for local generic model (green) for Case 3c (shell elements) and 4c (solid 

elements). The entire local model has an offset in z-direction 
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Figure 3.9: Geometry for local generic model (green) for Case 3d (shell elements) and 4d (solid 

elements). The gap, on the right side of the local model is 0 mm in the top and 1.9 mm in the 
bottom 

 

 
Figure 3.10: Zoom of geometry for local generic model (green) for Case 3e-g (shell elements) and 
4e-g (solid elements). The gap, on the right side, to the global model is 0.1, 0.01 respectively 0.001 

mm 

 

3.2.4 Case 4: Offset With Solid Elements 
Case 4 is, as Case 3, also divided into several sub-cases, the difference is however that Case 4 uses 
a local model consisting of solid elements, with geometries based on Case 3, and another magnitude 
of the offset for Case 4c. All sub-cases are summarized in Table 3.5. 
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Table 3.5: Summary of sub-cases for offset with shell elements 

Number of elements Gap relative global model [mm] 
Case no Element size 

[mm] x y z x=40 x=60 y=40 y=60 z=0 

4a Uniform 2.2 9 10 1 0 2 0 0 0 
4b Uniform 2.2 9 10 1 1 1 0 0 0 
4c Uniform 2.2 10 10 1 0 0 0 0 0.5 
4d Variable 10 10 1 0 0-1.9 0 0 0 
4e Variable 10 10 1 0 0.1 0 0 0 
4f Variable 10 10 1 0 0.01 0 0 0 
4g Variable 10 10 1 0 0.001 0 0 0 

 

3.3 Reference model 
For comparison of the results, all cases of local models for the tested methods are compared to a 
reference model. The reference model consists of shell and beam elements with the size 2 times 2 
mm according to Figure 3.11. 

 

Figure 3.11: 3D representation of the reference model 

 

3.4 Load Cases and Boundary Conditions 
Four different load cases are tested for all types of local models, where the loads for the first three 
load cases are applied consistent equally large on each node on the upper boundary (y-max), except 
the middle node. However, note that the load cases are not applied consistent over the geometry; the 
impact is twice as large at the outer corners as for the rest of the positions where the forces are 
applied.  
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The load cases are all small fictive values. All load cases and their corresponding boundary 
conditions are described in detail in Table 3.6. Common to all load cases is that all nodes on the 
lower boundary (y-min) are fixed. 
 
The load cases are used on all test cases for the generic model and also on a reference model with a 
dense mesh. 
 

Table 3.6: Load cases and their boundary conditions. Upper nodes are the nodes at y=100 except 
[50, 100, 0], lower nodes are all nodes at y=0, the central node is placed at [50, 50, 0] for shell 

models and [50, 50, 1] and [50, 50, -1] for solid models (half load in each node) 

Name Type of Load Magnitude and 
Direction  per Node Unit Boundary Condition 

Force_x Force, upper nodes [10, 0, 0] N Fixed, lower nodes 
Force_y Force, upper nodes [0, -10, 0] N Fixed, lower nodes 
Force_z Force, upper nodes [0, 0, 10] N Fixed, lower nodes 
Central_y Force, the central node [0, -50, 0] N Fixed, lower nodes 

 

  
 a) Force_x b) Force_y 

Figure 3.12: Definition of load case Force_x and Force_y 

 

 a) Force_z b) Central_y 

Figure 3.13: Definition of load case Force_z and Central_y  
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3.5 Evaluation of the results 
The results are interpreted and evaluated in three steps. Partly visually based on results plots of the 
displacement and stresses but also from diagrams of the displacements and stresses along a given 
line in the centre of the model. Depending on the load case, different stresses are studied. For 
Force_x the shear stress is studied and for Force_y as well as Central_y the normal stress in the y-
direction is studied. For all these load cases, the stress values are extracted from the mid-plane, 
which is the average of the top and bottom side of the element. Since Force_z causes a bending 
moment, the stress in the mid-plane will be zero or close to zero, therefore; the stress in the y-
direction on the top surface of the shell is studied. The directions of the stresses are chosen with 
respect to which direction has felt the largest impact for each of the load cases. The displacements 
are studied in the same direction as the applied load. 
 
To interpret the results, a few evaluation criteria are used; the quality of the connection, the 
accuracy of the displacement results and the accuracy of the stress results compared to reference 
values. Each evaluation criterion gives a score between 0 and 1, where 0 is a very poor result and 1 
is total consistency with the reference values. The scores from each criterion are then weighted to an 
overall total score.  
 

3.5.1 Evaluation Criterion 1 - Connection 
The first step of the evaluation is to investigate whether the connection between the two models 
works properly. For Glue, it is possible to plot the nodes that are glued to each other, see the 
example in Figure 3.14; it is also possible to look at reaction forces at the boundary between the 
models, to see that there is a connection. Furthermore, the quality of the connection may be studied 
with use of displacement plots, where it is possible to see how the model is bending due to the force 
applied. If there are large gaps between the models the quality of the connection is poor and should 
usually not be approved. However, for some methods it is impossible to completely remove all gaps 
due to that the distance between the coupled nodes can be large, but the boundary of the local model 
should still have approximately the same displacement as the global boundary. 

 

Figure 3.14: Example of contact results for Glue. Slaved nodes are marked with 1 and a red 
triangle, master segments are marked with 0 and a blue triangle 
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This criterion will give a score of either 1, 0.5 or 0. If there is a properly working connection the 
score will be 1, if there is a working connection but with large gaps or other defects, the score will 
be 0.5 and finally, the score is 0 if the method fails to connect the two models. 
 

3.5.2 Evaluation Criterion 2 – Displacements 
The second evaluation criterion is to look at the displacement results at a given line, Figure 3.15. 
The line goes through the entire model, both the global and local area. 
 

 

 

Figure 3.15: Lines along which node displacements and stresses are extracted 

 

The displacement results are extracted from the nodes at the middle line in the same direction as the 
applied load, for example; the displacement results for the x-component are extracted for the load 
case Force_x. The reference system used is the global system, and when solid elements are present, 
the average displacement is calculated between the top and bottom node for a given x-position to 
produce results in the mid-plane. 
 
The results are exported to Excel where data files are created which are then read in MATLAB 
where plots and criterion scores are calculated according to the formulas stated in Section 3.5.4 
below. The criterion score is calculated only from values within the local area. To be able to ignore 
the boundary effects, the two outer elements on each side of the local model are not evaluated. 
 

3.5.3 Evaluation Criterion 3 – Stresses 
The third evaluation criterion looks at the stress results at the same line as for the second criterion. 
As before, the line goes through the entire model, both the global and local area. 
 
The stress results are extracted from the nodes at the middle line. The direction of the extracted 
stress depends on the load case, discussed above. The reference system used is the global system, 
and all results are extracted from the middle plane of the elements, except for load case Force_z 
where the top plane is studied. When solid elements are present, the average stress is calculated 
between the top and bottom node for a given x-position, to produce results in the mid-plane. 
 

Middle 
line at 
y=50 
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The results are exported to Excel where data files are created which are then read in MATLAB 
where plots and criterion scores are calculated according the formulas stated in Section 3.5.4 below. 
The criterion score is calculated only from values within the local area. To be able to ignore the 
boundary effects, the two outer elements on each side of the local model are not evaluated. 
 

3.5.4 Calculations of Individually Criterion Scores 
Two different criterion scores are calculated for the displacement and the stress results respectively, 
which are then merged into one combined score for each evaluation criterion, m, and case, n. The 
method is influenced by Hovenga (2005), and is implemented in MATLAB according the code 
stated in Appendix A - MATLAB Script for Evaluation of the Parametric Study. The first criterion 
score-array is calculated with the Relative Error Method (REM), according to Equation 3.1, for 
values between x=44 and x=56. The choice of evaluated area is based on results from contour plots 
and on the fact that boundary effects will always be present. The error is therefore calculated for the 
local model except for the two outer elements on each side. The array for REM is plotted against the 
x-position and the lowest score is chosen as the Relative Error criterion score for the studied case. 
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The Relative Error Method is not associative, meaning that the results differ if the reference is 
compared to the case instead of the opposite; ),(),( refcasecritcaserefcrit REMREM . 
Therefore, the Relative Error Method tends to under predict some cases and a second method is 
introduced, the Factor Method (FM), explained in Equation 3.2. The array is also here plotted 
against the x-position between x=44 and x=56 and the lowest score is chosen as the factor criterion 
score for the studied case. 
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The Factor Method is, unlike the Relative Error Method, associative; 
),(),( refcasecritcaserefcrit FMFM .  

 

The two criteria scores are merged to a combined score with a weight factor of 2
1w for each 

criterion method, according to Equation 3.3, where j represents the two different criterion methods, 
REM and FM. This gives the mean values for the Relative Error Method and the Factor Method. 
For small difference between the reference values and the case values, the two criterion scores are 
close to each other. However, if the difference grows larger, the Factor Method gives a higher score. 
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Finally, the array for the combined score is plotted against the x-position between x=44 and x=56 
and the lowest score is chosen as the combined criterion score for the evaluation criterion and 
studied case. 
 

3.5.5 Total Criterion Score 
A total criterion score is calculated from the criterion scores from each evaluation criteria, 
according to equation 3.4, where m represents the three evaluation criterions and n the studied case. 
 

m

nmcombm
ntotal W

CRITW
CRIT ,,

,  (3.4) 

 
However, if the first evaluation criterion score is 0, the total criterion score will also be set to 0. The 
weight factors for the criterion are summarized in Table 3.1. Since the first evaluation criterion is 
not that detailed, the weight factor is smaller than for the other evaluation criteria and is set to half 
of the weight factor for the second and third criterion. 
 

Table 3.7: Weight factors for evaluation criterion 

Criterion number Weight factor, W 

1 - Connection 5
1  

2 - Displacements 5
2  

3 - Stresses 5
2  

 

3.5.6 Approved Results 
For an overall approved result, the fist criterion has to be greater or equal to 0.5, the second and 
third criterion have to have a score of at least 0.8 or higher, and finally, the total score has to be at 
least 0.9 or higher.  
 
The score for the second and third criteria are both in average 0.82 for the coarse global model, and 
the total score is in average 0.86 for the same model. The limits for approved results on the tested 
models are chosen after consideration with staff at Saab with respect to the values for the global 
model. The limits should not punish the individual criteria so hard, but the total score has to be 
better than for the coarse global model. 
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CHAPTER 4  
PARAMETRIC STUDY 

 
 
This chapter describes the parametric study performed on the generic model described in previous 
chapter. The choice of which methods to implement is based on available software, which methods 
that have not been used on Gripen before, requests from Saab and time aspects. The results and 
outcome from the simulations are presented here. The results are evaluated with three different 
criteria described in previous chapter. A user guide to all used methods is found in Appendix D 
User Guide to Used Methods. The individual, combined and total criteria scores are found in 
Appendix B Results from Parametric Study. 
 

4.1 Reference Values 
All load cases are applied to the reference model with 2 times 2 mm large shell and beam elements. 
These results are used as reference values to compare the results from each case with, when 
evaluating the simulations done for the different techniques. The maximum and minimum stresses 
and the displacements for all load cases can be found in Table 4.1. 
 

Table 4.1: Summary of stresses and displacement for the reference generic model. Displacements 
are defined in the same direction as the applied force. Stresses looked at: Force_x – yx , mid-plane; 

Force_y – y, mid-plane; Force_z – y, top plane and Central_y – y, mid-plane. 

 Force_x Force_y Force_z Central_y 

Min stress [MPa] 3.60e-2 -8.69e-1 -1.15 -2.57 
Max stress [MPa] 4.37e-1 -1-95e-2 2.75e1 2.28 
Min displacement [mm] 0 -4.80e-4 0 -5.93e-4 
Max displacement [mm] 2.49e-3 0 7.50e-1 0 
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 a) Displacement x-direction b) Stress xy, mid-plane 

Figure 4.1: Results from the reference generic model for load case Force_x 

 

 
 a) Displacement y-direction b) Stress y, mid-plane 

Figure 4.2: Results from the reference generic model for load case Force_y 

 

 
 a) Displacement z-direction b) Stress y, top plane 

Figure 4.3: Results from the reference generic model for load case Force_z 
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 a) Displacements y-direction b) Stress y, mid-plane 

Figure 4.4: Results from the reference generic model for load case Central_y 

 

4.1.1 Displacement Diagrams 
All cases of the evaluated methods are numerically compared to the reference model, but in the 
displacement diagrams, results from the coarse global model are also included for the understanding 
of the appearance outside the local model. The goal is to achieve results that follows the global 
results outside the local model, but are closer to the reference model in the local area. The reference 
values are shown in Figure 4.5 to Figure 4.6. 
 

  
 a) Force_x b) Force_y 

Figure 4.5: Reference values for displacement results, Force_x and Force_y 
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 a) Force_z b) Central_y 

Figure 4.6: Reference values for displacement results, Force_z and Central_y 

 

4.1.2 Stress Diagram 
As for the displacement criterion, all cases of the evaluated methods are numerically compared to 
the reference model, but in the stress diagrams, results from the coarse global model are also 
included. The reference values are shown in Figure 4.7 to Figure 4.8. 
 

 

 a) Force_x b) Force_y 

Figure 4.7: Reference values for stress results, Force_x and Force_y 

 



G. Ahlbert | Method Evaluation of Global-Local Finite Element Analysis 
 

 
31 

 
 a) Force_z b) Central_y 

Figure 4.8: Reference values for stress results, Force_z and Central_y 

 

4.2 Mesh Refinement 
Mesh refinement is implemented for all load cases. The HyperWorks package is used where 
HyperMesh is the pre-processor, RADIOSS the solver and HyperView the post-processor.  Due to 
the definition of the mesh refinement method, it is not possible to test different sub-cases with solid 
elements in the local area or with gaps or offsets. The used model is shown in Figure 4.9, and can be 
compared to Case 1 of the generic model, with 10 times 10 elements in the local area. 

 

Figure 4.9: Model for test of Mesh refinement. Red lines represents bars with same properties and 
dimensions as for the generic model 

 
Figure 4.10 and Figure 4.11 show examples of the results from the displacement and stresses. The 
figures shows load case Force_y, but the other load cases have similar ratio to the reference values. 
The results from the mesh refinement test follows the values from the global model in the coarse 
area, and gradually coming closer to the reference values. Due to this gradual transition, there are no 
boundary effects between the global and local area. 
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 a) Displacement graph b) Contour plot 

Figure 4.10: Displacement results from mesh refinement for load case Force_y 

 

 
 a) Stress graph b) Contour plot 

Figure 4.11: Stress results from mesh refinement for load case Force_y 

 
The combined criterion scores for mesh refinement are found in Table 4.2. 
 

Table 4.2: Combined criterion scores of results for mesh refinement 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.97 1.00 1.00 0.96 
2 - Stresses 0.98 1.00 1.00 0.99 
Total score 0.98 1.00 1.00 0.98 

Approved Yes Yes Yes Yes 
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4.3 RBE3 
RBE3 elements are implemented as interface elements for all load cases. The HyperWorks package 
is used where HyperMesh is the pre-processor, RADIOSS the solver and HyperView the post-
processor. The method used to define the interface elements is an automated Tcl-script provided by 
Altair. The nodes at the boundaries are defined and the script creates RBE3 elements to connect the 
models. The script is designed for Shell-To-Solid coupling which means that if a Shell-To-Shell 
coupling is used the properties of the RBE3 elements have to be modified or a new script could be 
constructed. For the tests performed here, the properties have been modified, see Appendix D User 
Guide to Used Methods, for the entire workflow. RBE3 is also available in other software but 
HyperWorks is used due to the automatic script that is available to simplify the implementation. 
 
The automated script is designed to make the local nodes independent (master) and the global nodes 
dependent (slave), meaning that the global nodes will follow the movement of the local nodes. This 
is not the traditional way to use RBE3 elements and therefore is some test performed were the 
RBE3 elements have been manually defined, were the local nodes are slaved to the global nodes, 
see Figure 4.12 for the difference in implementation. The automated method can have almost 
infinite numbers of master nodes connected to one slaved node, whereas the manual method have 
one or maximum two master nodes connected to one slave node. Due to time limitations of the 
project, these tests are only performed on Case 1 and Case 2, for all load cases. Figure 4.13 shows 
how the RBE3 elements have been defined around the local model for the different techniques. 
 

                 
 a) Automated script b) Manually defined 

Figure 4.12: Definitions of the RBE3 elements for the automated and manual methods. Master 
nodes are marked with a black triangle and slave nodes are marked with a white circle. 

 
 a) Automated script b) Manually defined 

Figure 4.13: Difference in placement of RBE3 elements for Case 2 between the automated script 
and the manually defined method. The RBE3 elements are represented with yellow lines 
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Another difference between the automated technique and the manually defined is the weight factors. 
The weight factors are default 1 in the automated script, meaning that the displacement in the slave 
node will be the average displacement of the master nodes, independent of the placement of the 
nodes. In the manually defined method, the weight factors are defined with respect to the geometry 
and placement of the nodes. For example, if the slave node is placed according to Figure 4.14, the 
contribution from node A is 1/3 and the contribution from node B is 2/3. The weight factors can be 
adjusted with a Tlc-script provided by Altair. 

 

Figure 4.14: Definition of weight factors for manual method 

 
Since RBE3 works independently of the size of the gap, all load cases will have a working 
connection. However since RBE3 does not have any stiffness the stiffness of the model will 
decrease, if gaps are present. 
 
The results from all test cases for the automated method are summarized in Table 4.3. The results 
from the manually defined method are summarized in Table 4.4. 
 

A B 

l 

l/3 

W=1/3 W=2/3 
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Table 4.3: Summary of results for RBE3 automated method in HyperMesh. 

Load case approved? 
Case no 

Force_x Force_y Force_z Central_y 

1 No No No No 
2 Yes Yes No Yes 
3a Yes Yes Yes No 
3b Yes Yes Yes Yes 
3c Yes Yes Yes Yes 
3d Yes Yes Yes Yes 
3e Yes Yes Yes Yes 
3f Yes Yes Yes Yes 
3g Yes Yes Yes Yes 
4a Yes Yes No Yes 
4b Yes Yes No No 
4c Yes No No No 
4d Yes Yes No Yes 
4e No Yes No Yes 
4f Yes Yes No Yes 
4g Yes Yes No Yes 

 

Table 4.4: Summary of results for RBE3 manually defined method in HyperMesh. 

Load case approved? 
Case no 

Force_x Force_y Force_z Central_y 

1 Yes Yes Yes Yes 
2 Yes Yes No Yes 

 

4.3.1 Case 1: Shell Elements 
For the automated methods, none of the load cases are approved, due to a bad matching of the stress 
values, however, the displacement values are almost identical to the reference model for most load 
cases. For the manually defined method, the stress values match the reference model much better 
and all load cases are in this case approved. 
 
Figure 4.15 shows an example of how the displacement results look like for the automated RBE3 
technique and load case Force_x. Figure 4.16 shows the corresponding stress results and Figure 
4.17 shows the criteria scores for the displacement and stress criteria. It is here possible to see that 
the displacement follows the reference model quite good but the results for the stresses are worse. 
Due to the stress results, none of the load cases are approved. 
 
The results from the automated RBE3 technique, Case 1, follow the coarse global model in the 
global area quite good. However, at the boundary between the global and local model, the boundary 
effects are large and are influencing the results in the local area in a bad way. 
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 a) Displacement graph b) Contour plot 

Figure 4.15: Displacement results from RBE3 (automated) Case 1 for load case Force_x 

 

 
 a) Stress graph b) Contour plot 

Figure 4.16: Stress results from RBE3 (automated) Case 1 for load case Force_x 

 

 
 a) Displacement criteria scores b) Stress criteria scores 

Figure 4.17: Criteria scores for RBE3 (automated) Case 1, Force_x 
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The combined criterion scores for Case 1, automated method are found in Table 4.5. 
 

Table 4.5: Combined criterion scores of results from Case 1 for RBE3 automated method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.96 0.99 0.99 0.82 
2 - Stresses 0.52 0.52 0.76 0.53 
Total score 0.79 0.80 0.90 0.74 

Approved No No No No 
 
Figure 4.18 shows the displacement results for the manual RBE3 method for load case Force_x and 
Figure 4.19 shows the corresponding stress results. Compared to the automated method above, the 
manual method shows better results, mainly when the stress is considered. The boundary effects are 
smaller, and the local values are closer to the reference model. 
 
From the stress and displacement results it is clearly shown that the boundary effects that were seen 
in the automatic method are no longer present, as a consequence of this, the local values are much 
better, practically identical to the reference values.  
 

 
 a) Displacement graph b) Contour plot 

Figure 4.18: Displacement results from RBE3 (manual) Case 1 for load case Force_x 
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 a) Stress graph b) Contour plot 

Figure 4.19: Stress results from RBE3 (manual) Case 1 for load case Force_x 

 
The combined criterion scores for Case 1, manual method are found in Table 4.6. 
 

Table 4.6: Combined criterion scores of results from Case 1 for RBE3 manually defined method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.96 1.00 1.00 0.95 
2 - Stresses 1.00 1.00 0.88 1.00 
Total score 0.98 1.00 0.95 0.98 

Approved Yes Yes Yes Yes 
 
The combined criteria score for load Case 1 is plotted for both the automated and manual method in 
Figure 4.20. The improvement when using the manual method instead of the automated script is 
clearly shown here, especially for the stress results.  
 

  
 a) Displacement combined criterion score b) Stress combined criterion score 

Figure 4.20: Combined criteria scores for RBE3 Case 1 (automated vs. manual), Force_x 
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When the stress results are compared for the automated and manual method as in FIGURE, it is 
clearly shown that the automated method has large unwanted boundary effect. Other load cases 
have similar appearance. 
 

 

Figure 4.21: Comparison of stress results for Case 1, Central_y. Automated vs. manual method 

4.3.2 Case 2: Solid Elements 
Case 2 is approved for all load cases except Force_z were the stress values differ too much from the 
reference model, both for the automated method and the manually defined method. All other load 
cases show good results for both displacements and stresses. 
 
Figure 4.22 shows an example of how the displacement results look like for the automated RBE3 
technique and load case Force_y. Figure 4.23 show the corresponding stress results. It is here 
possible to see that the displacement follows the reference model quite good. There is a moment 
effect, causing displacement in the z-direction which can be seen within the local area, which is due 
to that the beams in the global model are defined with an offset causing the entire model to bend. 
The stress results are worse than the displacements. 
 
As for Case 1, the stress results are quite good in the global area but the boundary effects are so 
large that the result in the local area becomes bad. 
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 a) Displacement graph b) Contour plot 

Figure 4.22: Displacement results from RBE3 (automated) Case 2 for load case Force_y 

 

 
 a) Stress graph b) Contour plot 

Figure 4.23: Stress results from RBE3 (automated) Case 2 for load case Force_y 

 
The combined criterion scores for automated method, Case 1 are found in Table 4.7. 
 

Table 4.7: Combined criterion scores of results from Case 2 for RBE3 automated method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.95 0.99 0.99 0.99 
2 - Stresses 0.92 0.92 0.25 0.92 
Total score 0.95 0.97 0.70 0.96 

Approved Yes Yes No Yes 
 
Figure 4.24shows the displacement results for the manual RBE3 method for load case Force_y and 
Figure 4.25 shows the corresponding stress results. Compared to the automated method above, the 
manual method show better results, mainly when the stress is considered. It is still quite large 
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boundary effects, depending on the load case, but the local results is improved compared to the 
automated method. The boundary effects are largest for load case Force_y and Force_z. 
 

 
 a) Displacement graph b) Contour plot 

Figure 4.24: Displacement results from RBE3 (manual) Case 2 for load case Force_y 

 

 
 a) Stress graph b) Contour plot 

Figure 4.25: Stress results from RBE3 (manual) Case 2 for load case Force_y 

 
The combined criterion scores for manual method, Case 1 are found in Table 4.8. 
 

Table 4.8: Combined criterion scores of results from Case 2 for RBE3 manually defined method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.96 0.99 1.00 0.94 
2 - Stresses 1.00 1.00 0.27 0.99 
Total score 0.98 1.00 0.71 0.97 

Approved Yes Yes No Yes 
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The combined criteria score for load Case 2 is plotted for both the automated and manual method in 
Figure 4.26. It can be seen that the manual method is better for this specific load case. 
 

   
 a) Displacement combined criterion score b) Stress combined criterion score 

Figure 4.26: Combined criteria scores for RBE3 Case 2 (automated vs. manual), Force_y 

 

4.3.3 Case 3: Offset With Shell Elements 
The results from all sub-cases for case 3, summarized in Table 4.9, show that RBE3 works for all 
the load cases, except for case 3b with the Central_y force. 
 
If the total score is compared against the corresponding score for the global model, it is shown that 
all cases for load case Force_y except Case 3d are lower than the global score. Even though these 
cases are approved, it is no meaning using this method when the global model gives better results. 
 

4.3.4 Case 4: Offset With Solid Elements 
The results from all sub-cases for case 4, summarized in Table 4.10, shows that RBE3 is not a 
useful method for load case Force_z, were none of the sub-cases are approved. The results show 
that the method works fine for displacements and when a sub-case is not approved, it is usually due 
to bad results for the stresses. As for Case 3, all approved cases except Case 4c has lower score than 
the global model when looking at the load case Force_y. 
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Table 4.9: Combined criterion scores of results from Case 3 for RBE3 automated method 

Case no  Force_x Force_y Force_z Central_y 

3a 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 1.00 0.99 0.99 
 2 - Stresses 0.88 0.88 0.92 0.89 
 Total score 0.93 0.95 0.97 0.95 

 Approved Yes Yes Yes Yes 

3b 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 1.00 0.99 0.69 
 2 - Stresses 0.88 0.92 0.94 0.93 
 Total score 0.94 0.97 0.97 0.85 

 Approved Yes Yes Yes No 

3c 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 0.96 0.99 0.98 
 2 - Stresses 0.90 0.91 0.99 0.89 
 Total score 0.94 0.95 0.99 0.95 

 Approved Yes Yes Yes Yes 

3d 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 1.00 0.99 0.99 
 2 - Stresses 0.90 0.94 0.96 0.94 
 Total score 0.94 0.98 0.98 0.97 

 Approved Yes Yes Yes Yes 

3e 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 0.99 0.99 0.99 
 2 - Stresses 0.91 0.92 0.98 0.91 
 Total score 0.95 0.97 0.99 0.96 

 Approved Yes Yes Yes Yes 

3f 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 0.99 0.99 0.99 
 2 - Stresses 0.91 0.92 0.98 0.91 
 Total score 0.95 0.97 0.99 0.96 

 Approved Yes Yes Yes Yes 

3g 1 - Connection 1 1 1 1 
 2 - Displacements 0.96 0.99 0.99 0.99 
 2 - Stresses 0.91 0.92 0.98 0.91 
 Total score 0.95 0.97 0.99 0.96 

 Approved Yes Yes Yes Yes 
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Table 4.10: Combined criterion scores of results from Case 4 for RBE3 automated  method 

Case no  Force_x Force_y Force_z Central_y 

4a 1 - Connection 1 1 1 1 
 2 - Displacements 0.95 1.00 0.99 0.99 
 2 - Stresses 0.82 0.87 0.26 0.89 
 Total score 0.91 0.95 0.70 0.95 

 Approved Yes Yes No Yes 

4b 1 - Connection 1 1 1 1 
 2 - Displacements 0.95 1.00 0.99 0.44 
 2 - Stresses 0.84 0.90 0.26 0.91 
 Total score 0.92 0.96 0.70 0.74 

 Approved Yes Yes No No 

4c 1 - Connection 1 1 1 1 
 2 - Displacements 0.97 0.84 0.99 0.97 
 2 - Stresses 0.93 0.80 0.10 0.77 
 Total score 0.96 0.86 0.64 0.89 

 Approved Yes No No No 

4d 1 - Connection 1 1 1 1 
 2 - Displacements 0.95 1.00 0.99 0.99 
 2 - Stresses 0.85 0.94 0.26 0.94 
 Total score 0.92 0.98 0.70 0.97 

 Approved Yes Yes No Yes 

4e 1 - Connection 1 1 1 1 
 2 - Displacements 0.87 0.90 0.10 0.95 
 2 - Stresses 0.86 0.90 0.00 0.87 
 Total score 0.89 0.92 0.24 0.93 

 Approved No Yes Yes Yes 

4f 1 - Connection 1 1 1 1 
 2 - Displacements 0.95 0.99 0.99 0.99 
 2 - Stresses 0.92 0.92 0.25 0.92 
 Total score 0.95 0.97 0.70 0.96 

 Approved Yes Yes No Yes 

4g 1 - Connection 1 1 1 1 
 2 - Displacements 0.95 0.99 0.99 0.99 
 2 - Stresses 0.92 0.92 0.25 0.92 
 Total score 0.95 0.97 0.70 0.96 

 Approved Yes Yes No Yes 
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4.4 Glue 
The Glue method is implemented for all sub-cases. MSC Patran 2010 is used as pre-processor, MSC 
Nastran 2012 is used as a solver and MSC Patran is once again used as post-processor. The 
workflow is presented in Appendix D User Guide to Used Methods. 
 
When using Glue in MSC Patran, the global and local models are first defined as two contact 
regions and the glue condition is implemented in the contact table during analysis set up. Values for 
tolerances and gaps can be defined manually or automatically. If the models have different 
dimensions, it is important to ignore the thickness to avoid a hinge effect. For more information 
about different settings for Glue, the reader is referred to for example MSC Nastran Implicit 
Nonlinear User’s Guide, 2010. 
 
A summary of all test cases for Glue is found in Table 4.11. 
 

Table 4.11: Summary of results for glue method in MSC Patran. 

Load case approved? 
Case no 

Force_x Force_y Force_z Central_y 

1 Yes Yes Yes Yes 
2 Yes Yes No Yes 
3a No No No No 
3b No No No No 
3c No No No No 
3d No No No No 
3e No No No No 
3f No No No No 
3g Yes Yes No Yes 
4a No No No No 
4b No No No No 
4c Yes No No Yes 
4d No No No No 
4e No No No No 
4f No No No No 
4g No No No No 

 

4.4.1 Case 1: Shell Elements 
Case 1 gives acceptable results for all load cases, and the displacements are almost identical with 
the reference values.  
 
Figure 4.27 shows the displacement results for glue Case 1 and Figure 4.28 shows the 
corresponding stress results. 
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 a) Displacement graph b) Contour plot 

Figure 4.27: Displacement results from glue Case 1 for load case Force_x 

 

 
 a) Stress graph b) Contour plot 

Figure 4.28: Stress results from glue Case 1 for load case Force_x 

 
The combined criterion scores for Case 1 are found in Table 4.12. 
 

Table 4.12: Combined criterion scores of results from Case 1 for Glue method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.99 0.99 0.99 0.95 
2 - Stresses 0.98 0.99 0.86 1.00 
Total score 0.99 0.99 0.94 0.98 

Approved Yes Yes Yes Yes 
 
Even though all load cases are approved, this method should probably not be used for load cases 
similar to Force_z due to that this gives a lower total score than the global model. 
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4.4.2 Case 2: Solid Elements 
Case 2 gives acceptable results for all load cases, except Force_z where the stress differs too much 
from the reference model. Figure 4.29 shows the displacement results for glue Case 2, Central_y 
and Figure 4.30 shows the corresponding stress results. The other approved load cases have similar 
appearance when they are compared to the reference values. 
 

 
 a) Displacement graph b) Contour plot 

Figure 4.29: Displacement results from glue Case 2 for load case Central_y 

 

 
 a) Stress graph b) Contour plot 

Figure 4.30: Stress results from glue Case 2 for load case Central_y 

 
The combined criterion scores for Case 2 are found in Table 4.13.  
 

Table 4.13: Combined criterion scores of results from Case 2 for Glue method 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.93 0.97 0.83 0.95 
2 - Stresses 0.97 0.96 0.70 0.96 
Total score 0.96 0.97 0.81 0.97 
Approved Yes Yes No Yes 
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4.4.3 Case 3: Offset With Shell Elements 
Case 3 tests how sensible the method is for offsets and non-cohesive geometry and the results are 
summarized in Table 4.14. The results show that the method has problems dealing with gaps in the 
model. To achieve approved glued contact, the gap cannot be larger than 0.05 % of the shell 
thickness. 
Since the tolerance region is defined normal to the contact section, it is not possible to use this 
method for offsets that are normal to the shell, in this case the z-direction. 
 
An example of how the connection looks like can be seen in Figure 4.31. All nodes around the local 
models are glued except the ones at the gap. The other load cases without working connection have 
the same appearance. 
 

 

Figure 4.31: Contact results for Glue Case 3a. Red triangles and 1 mark slave nodes and blue 
triangles and 0 mark master segments 

 

4.4.4 Case 4: Offset With Solid Elements 
Just as Case 3, Case 4 is also testing how sensible the method is for offsets and non-cohesive 
geometry; the difference is that the local model is built of solid elements here. The results are 
summarized in Table 4.15 and it shows that the method has problems with gaps at the interface 
between shell and solid elements. All sub-cases are unapproved except Case 4c where Force_x and 
Central_y are approved, due to that the offset is within the thickness of the solid. 
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Table 4.14: Combined criterion scores of results from Case 3 for Glue method 

Case no  Force_x Force_y Force_z Central_y 

3a 1 - Connection 0 0 0 0 
 2 - Displacements 0.96 0.88 0.30 0.95 
 2 - Stresses 0.46 0.92 0.67 0.93 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

3b 1 - Connection 0 0 0 0 
 2 - Displacements 0.97 0.88 0.31 0.69 
 2 - Stresses 0.50 0.93 0.58 0.94 
 Total score 0.00 0.00 0.00 0.00 
 Approved No No No No 

3c 1 - Connection 0 0 0 0 
 2 - Displacements 0.00 0.00 0.00 0.00 
 2 - Stresses 0.00 0.00 0.00 0.00 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

3d 1 - Connection 0 0 0 0 
 2 - Displacements 0.96 0.89 0.30 0.94 
 2 - Stresses 0.62 0.91 0.67 0.64 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

3e 1 - Connection 0 0 0 0 
 2 - Displacements 0.95 0.88 0.30 0.93 
 2 - Stresses 0.73 0.89 0.68 0.90 
 Total score 0.00 0.00 0.00 0.00 
 Approved No No No No 
3f 1 - Connection 0.5 0.5 0.5 0.5 
 2 - Displacements 0.99 0.99 0.99 0.96 
 2 - Stresses 0.96 0.99 0.90 1.00 
 Total score 0.88 0.89 0.85 0.88 
 Approved No No No No 

3g 1 - Connection 1 1 1 1 
 2 - Displacements 0.94 0.88 0.30 0.92 
 2 - Stresses 0.98 0.90 0.75 0.91 
 Total score 0.97 0.91 0.62 0.93 

 Approved Yes Yes No Yes 
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Table 4.15: Combined criterion scores of results from Case 4 for Glue method 

Case no  Force_x Force_y Force_z Central_y 

4a 1 - Connection 0 0 0 0 
 2 - Displacements 0.87 0.84 0.56 0.95 
 2 - Stresses 0.41 0.88 0.92 0.88 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

4b 1 - Connection 0 0 0 0 
 2 - Displacements 0.89 0.84 0.57 0.70 
 2 - Stresses 0.45 0.88 0.81 0.88 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

4c 1 - Connection 1 1 1 1 
 2 - Displacements 0.86 0.84 0.55 0.92 
 2 - Stresses 0.90 0.79 0.64 0.84 
 Total score 0.90 0.85 0.68 0.91 

 Approved Yes No No Yes 

4d 1 - Connection 0 0 0 0 
 2 - Displacements 0.87 0.84 0.56 0.95 
 2 - Stresses 0.50 0.83 0.47 0.79 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

4e 1 - Connection 0 0 0 0 
 2 - Displacements 0.87 0.84 0.56 0.93 
 2 - Stresses 0.67 0.85 0.48 0.86 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

4f 1 - Connection 0 0 0 0 
 2 - Displacements 0.09 0.52 0.55 0.70 
 2 - Stresses 0.88 0.00 0.33 0.00 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 

4g 1 - Connection 0 0 0 0 
 2 - Displacements 0.74 0.81 0.55 0.89 
 2 - Stresses 0.91 0.00 0.82 0.00 
 Total score 0.00 0.00 0.00 0.00 

 Approved No No No No 
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4.5 DMIG 
DMIG implemented in MSC Nastran 2012, according to the workflow presented in Appendix D 
User Guide to Used Methods. There are several different ways of dealing with superelements in 
Nastran and other software, but this specific technique is only available in MSC Nastran. The 
method chosen here is a semi-automatic attachment of the local model, for alternative methods, the 
reader is referred to for example Robinsson (2009).  
 
This Global-Local analysis in MSC Nastran is performed in two basic steps, first the global model 
is defined without the local model, and the global model is reduced with ASET at the boundary to 
the local model. The analysis is then set up to write the boundary matrices to an .op2 file and 
connection data to an .asm file. The second step is to define the local model and attach it to the 
global model by using the .op2 and .asm files as input. 
 
It is important to notice that DMIG is not a Global-Local method in the same way as the previous 
tested methods. The mesh density, node positions and element types have to be compatible between 
the global and local model and due to this; the method has to be combined with another Global-
Local method to achieve a higher accuracy in the local model. The method used to be combined 
with DMIG can be any of the methods tested in this thesis or another Global-Local method. In this 
case, two different integrated analyses are used in combination with DMIG, both mesh refinement 
and RBE3. Furthermore, only the first case with shell element is studied. However, if the RBE3 
method is used, all load cases are possible to perform but this is already tested for RBE3 separately. 
 

4.5.1 DMIG with Mesh Refinement 
To achieve mesh compatibility at the boundary, mesh refinement is used at the global model, giving 
an element set as shown in Figure 4.32. To simplify the refinement process, the model is based on 
the generic global model and the refinement is performed in two steps; first by splitting the 
elements on the boundary to the local model in half, and thereafter divide each element in 3 equally 
sized elements, giving a total number of 12 elements, 1.67 mm large, on the boundary to the local 
model. Also the outer elements are split so that all are 10 mm; this is to reduce the size of the 
refinement area. 
 

 

Figure 4.32: Global model used for DMIG with mesh refinement 
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The mesh refinement could be performed on the local model instead, important to consider then is 
that the distance to the boundary should be large enough. The reason why the mesh refinement is 
performed on the global model in this example is to eliminate the risk of boundary effects in the 
local model. It is also important to consider that triangular elements increase the stiffness of the 
model and could therefore influence the result of the local model, independently of the placement of 
the refinement. 
 
Figure 4.33 shows the displacement results for DMIG with mesh refinement and Figure 4.34 shows 
the corresponding stress results. The other load cases have similar appearance compared to the 
reference values. Since the global and local models are defined separately, only the results from the 
local model are plotted. 
 

 
 a) Displacement graph b) Contour plot (local model) 

Figure 4.33: Local displacement results from DMIG with mesh refinement for load case Force_y 

 

 
 a) Stress graph b) Contour plot (local model) 

Figure 4.34: Local stress results from DMIG with mesh refinement for load case Force_y 

 
The results from test Case 1 are summarize in Table 4.16, and the method show approved results for 
all load cases. 
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Table 4.16: Combined criterion scores of results from Case 1 for DMIG with mesh refinement 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.99 1.00 1.00 0.94 
2 - Stresses 1.00 1.00 1.00 1.00 
Total score 1.00 1.00 1.00 0.97 

Approved Yes Yes Yes Yes 
 

4.5.2 DMIG with RBE3 
An alternative to perform DMIG combined with mesh refinement of the global model is to use 
interface elements within the local model, such as RBE3 elements. ASET nodes are then connected 
to the fine mesh with RBE3 elements according to the principle in Figure 4.35. The advantage with 
this method is that the global model is unmodified and no triangular elements with increased 
stiffness. However if there are many nodes at the boundary, it can be tricky to define all RBE3 in 
the right way if this is done manually.  
 

 

Figure 4.35: Principle of DMIG with RBE3. Black dots represents ASET nodes and dashed lines 
RBE3 coupling 

 

The RBE3 elements are defined with all degrees of freedom and weight factor 1 for all nodes.  
 
The local model used is the same as in previous DMIG example, with 1.67 mm quadratic elements. 
Furthermore, the global model is modified according to Figure 4.36, so that the results will be 
comparable with DMIG with mesh refinement. 
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Figure 4.36: Global model used for DMIG with RBE3 elements 

 
Figure 4.37 shows the displacement results for DMIG with RBE3 with load case Central_y, and 
Figure 4.38 shows the corresponding stress results. The other load cases have similar appearance 
compared to the reference values. Since the global and local models are defined separately, only the 
results from the local model are plotted. 
 

 
 a) Displacement graph b) Contour plot (local model) 

Figure 4.37: Local displacement results from DMIG with RBE3 for load case Central_y 
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 a) Stress graph b) Contour plot (local model) 

Figure 4.38: Local stress results from DMIG with RBE3 for load case Central_y 

 
The results from test Case 1 is summarize in Table 4.17. The results can not be directly compared 
with the test case with mesh refinement due to that the refinement is in the global model and is 
therefore not having any boundary effects due to different element sizes next to each other.  
 
All load cases for DMIG with RBE3 are approved. 
 

Table 4.17: Combined criterion scores of results from Case 1 for DMIG with RBE3 

 Force_x Force_y Force_z Central_y 

1 - Connection 1 1 1 1 
2 - Displacements 0.98 1.00 0.99 0.91 
2 - Stresses 0.89 0.93 0.95 0.93 
Total score 0.95 0.97 0.98 0.94 

Approved Yes Yes Yes Yes 
 
 
 
 





 
57 

 
 
 
 
 
 
 

CHAPTER 5  
GRIPEN TEST STUDY 

 
 
In this chapter two integrated techniques are applied on a modified part of Gripen VU in the 
HyperWorks package. The part studied is a wall at the rear body, with an attachment for one of the 
motors. The wall is first modelled with a coarse mesh without the attachment, then the attachment 
and the closest surrounding are modelled with shell elements with mesh refinement and lastly the 
local model with the attachment is modelled with solid elements attached to the global model with 
RBE3 elements. Result plots are shown in Appendix C - Results from Gripen Test Study. 
 

5.1 Model Description 
The model studied in this chapter is a part of a wall at the rear body of Gripen, shown in Figure 5.1. 
The model has been modified and does not have true geometry and loads, it could however be seen 
as a good example of a wall on an aircraft. 
 
The attachment is fixed to the wall with six bolts; these bolts will not be modelled as its true 
geometry in any of the test performed for this wall. 
 

 

Figure 5.1: Model for Gripen Test Study - Wall 
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The local coordinate system is found in the upper left corner with the same direction as the global 
coordinate system seen in Figure 5.1. The material used is aluminium with the same properties as 
for the generic model, see Table 3.2. 
 

5.2 Load Cases and Boundary Conditions 
Three load cases are extracted from the results of the global model of Gripen, using Intplot, an in-
house post-processing software at Saab. All load cases are modified, just as the whole model, but 
can be seen as good examples of possible loads on an aircraft.  
 
Each of the chosen load cases represents a manoeuvre and they are the three top load cases that give 
the highest stresses in the wall. The forces for all load cases are summarize in Table 5.1 and 
illustrated in Figure 5.2. The boundary conditions are approximated as stated in Table 5.2, due to 
stiffness of adjacent shells and fames. 
 

Table 5.1: Forces for Gripen Test Study 

  Load case 1 (1025) Load case 2 (3142) Load case 3 (6505) 

Nodes at right boundary (x-max) [N] 
907 zFx  

145zF  

700xF  

39008.4 zFz  

510xF  

29502 zFz  
Nodes at top boundary (z-min) [N] - - 10xF  

Nodes at lower boundary  (z-max) [N] - - 101.0 xFx  

Top pressure [kPa] 30yP  30yP  30yP  

Attachment [kN] 7zF  7zF  7zF  
 

Table 5.2: Boundary conditions for Gripen Test Study 

  Load case 1 (1025) Load case 2 (3142) Load case 3 (6505) 

Nodes at left boundary (x-min) [-] Fixed (all DOF) Fixed (all DOF) Fixed (all DOF) 
Nodes at right boundary (x-max) [-] Fixed, y-translation Fixed, y-translation Fixed, y-translation 
Nodes at top boundary (z-min) [-] Fixed, y-translation Fixed, y-translation Fixed, y-translation 
Nodes at lower boundary  (z-max) [-] Fixed, y-translation Fixed, y-translation Fixed, y-translation 

 

 
 a) Load case 1 b) Load case 2 c) Load case 3 

Figure 5.2: Illustration of load cases for wall structure 

 
The load in the attachment is creating a moment due to that it is placed at a distance from the wall. 
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5.3 Global model 
The wall is first modelled as a global model with coarse mesh, without the attachment. The 
elements used are quadratic, first order, shell elements with a thickness of 1.7 mm and two types of 
beams; with a rectangular cross-section and with a T-shaped cross-section, both shown in Figure 
5.3. The global model is used as a reference to the other two methods where Global-Local analysis 
is preformed, even though a more dense mesh or physical test values would have been 
advantageously to compare the methods with. 
 

 

Figure 5.3: Dimensions of the beams used in the global model. Measurements in mm 

 

The entire model is shown in Figure 5.4, where it is also possible to see the placement of the 
different beam types. 

 

Figure 5.4: Global model for the wall with outer dimensions in mm. White lines represent T-
shaped bars and blue lines represent rectangular beams. The red lines in the centre of the model 

are RBE3 element for the force in the attachment 
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To be able to apply a load in the attachment, an RBE3 is used with for independent master nodes at 
the wall connected to one dependent slave node where the force is applied. All translational degrees 
of freedom for the master nodes are connected to all translational and rotational degrees of freedom 
in the slave node. The weight factor is one for each node. See Figure 5.5 for the applied settings. 
 

  
 a) Weight factors b) Degrees of freedom 

Figure 5.5: Settings for the nodes of the RBE3-representation of the attachment 

 
The results from the global model are shown in Results from Gripen Test Study. 
 

5.4 Reference model 
A reference model, with a coarse mesh is constructed from the global model. Mesh refinement is 
used on the entire model, with a target element size of 15 mm, all other settings are the same as for 
the global model. The forces are applied only on the nodes consistent with the global model. The 
model is found in  
 

 

Figure 5.6: Reference model with a target element size of 15 mm. White lines represent T-shaped 
bars and blue lines represent rectangular beams. The red lines in the centre of the model are RBE3 

element for the force in the attachment 
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5.5 Mesh Refinement 
To achieve a higher accuracy in the attachment, mesh refinement is used. Mesh refinement is 
chosen due to the good results in the parametric study, where mesh refinement was the method with 
the highest average score over all load cases. The attachment is modelled with small shell element, 
and is attached to the wall with six RBE2 elements, representing the bolts. For a load transfer within 
the holes of the local model, RBE2 are used as spokes in the holes and a bar is defined between the 
two central nodes, see Figure 5.8. The attachment force is then applied on the middle of this bar. 
 
The bars within the mesh refinement are also split into the same lengths as the shell elements. The 
mesh is shown in Figure 5.7.  
 

  
 a) Global model b) Local model 

Figure 5.7: Mesh refinement of the wall 

 

Figure 5.8: RBE2 elements in the holes of the attachment with a bar between the central nodes 

 



G. Ahlbert | Chapter 5: Gripen Test Study 
 

 
62 

The displacement stress in middle layer is used for results evaluation. Contour plots for 
displacement results in x, y and z direction as well as stress results for von Mises and shear stress 
are found in Appendix C Results from Gripen Test Study. 
 
There are some local maximum points where the RBE3 elements are connected to the wall, seen in 
Figure 5.9.  The results are within reasonable limits; however, the RBE3 to connect the attachment 
to the wall may well be replaced by another method. 

 

Figure 5.9: Local von Mises stress results, in middle surface, for load case 1 and mesh refinement 

 

5.6 RBE3 
As an alternative to the mesh refinement described above, the automated RBE3 technique is used on 
the model. It would have been preferable to use the manual method but this is not used due to the 
large number of nodes on the local model. Instead, the local model is much larger than in the 
parametric study, to give the boundary effects an opportunity to fade before reaching the true area 
of interest, which in this case is the attachment. 
 
The local model with the attachment is modeled with solid 10-noded tetra elements, attached to the 
global model with RBE3 elements. The attachment is connected to the wall within the local model 
with glued contact. For simplicity reasons, the local model is cut out from the mesh refinement, 
thereof the shape of the local model and the splitting of the shell elements closest to the local model. 
As previous case, RBE2 elements are defined in the holes of the local model with a bar between the 
central nodes, where the attachment force is applied. The mesh is shown in Figure 5.10 and Figure 
5.11 shows one of the RBE3 elements. 
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 a) Global model b) Local model 

Figure 5.10: RBE3 used to connect the local model with the global model. RBE3 are represented 
with yellow lines. 

 

 
Figure 5.11: Zoom of one RBE3, represented with yellow lines 

 

The displacement stress in middle layer is used for results evaluation. Contour plots for 
displacement results in x, y and z direction as well as stress results for von Mises and shear stress 
are found in Appendix C Results from Gripen Test Study. 
 
There are large boundary effects, seen in Figure 5.12, due to that the element size differs much. 
Another effect that is not seen in the shell models are locally high stresses in radiuses. 
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Figure 5.12: Local von Mises stress resulting, middle surface, for load case 1, RBE3 and Glue 

 

5.7 Results 
The test performed in the Gripen test study are evaluated in two points, shown in Figure 5.13. The 
resultant magnitude of the displacement is then compared with the reference model for all tests and 
load cases, with results stated in Table 5.4 and Table 5.5. The average absolute difference for the 
two examined points are compared to the reference model are calculated and shown in Table 5.3. 
Contour plots of the displacement in each direction and of the von Mieses stress as well as the shear 
stress is also reviewed for the results evaluation. These plots are found in Appendix C Results from 
Gripen Test Study. 
 

  
 a) Result point 1 (lug) b) Result point 2 (beam cross) 

Figure 5.13: Studied result points for Gripen test study. Point 1 is placed in the centre of the lug, 
where the load is applied and point 2 is placed on the back side of the wall were the beams are 

crossing 

 
 

Result point 1 

Result point 2 
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Table 5.3: Average absolute difference for point 1 and 2 compared with reference model 

 Load case 1 Load case 2 Load case 3 Average 

Global Model 140 % 92 % 63 % 98 % 
Mesh Refinement 223 % 123 % 118 % 155 % 
RBE3 148 % 98 % 67 % 104 % 

 

Table 5.4: Displacement [mm] in point 1 (lug) for Gripen Test Study 

 Load case 1 Load case 2 Load case 3 

Reference Model 1.380 1.584 2.485 
Global Model 3.304 3.407 3.584 
Mesh Refinement 6.401 4.981 7.350 
RBE3 3.405 3.475 3.704 

 

Table 5.5: Displacement [mm] in point 2 (beam cross) for Gripen Test Study 

 Load case 1 Load case 2 Load case 3 

Reference Model 1.348 1.978 1.882 
Global Model 3.252 3.322 3.411 
Mesh Refinement 2.457 2.606 2.657 
RBE3 3.347 3.498 3.474 
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CHAPTER 6  
EVALUATION AND CONCLUSIONS 

 
 
In this chapter the evaluating of all results is summarized and the conclusions from the parametric 
study and final test are stated. The methods are evaluated in the software used for this study, 
however some of the advantages or disadvantages of the method concerning the implementation 
may perhaps not be present in other software. For a more thorough discussion around the 
conclusions, the reader is refereed to Chapter 7 Discussion. 
 

6.1 Evaluation of Parametric Study 

6.1.1 Mesh Refinement 
The mesh refinement technique requires a relative large area for the transition from the coarse 
global model to the fine local area of interest. It has to be defined within the global model which 
increases file size and the demand of time and computational power. Another disadvantage of the 
method is that it is not possible to use different types of elements, for example a Shell-To-Solid 
coupling. However, when comparing the results to the reference model, the results in the local area 
is almost identical to the reference model, both when looking at displacements and stresses.  
 
When doing mesh refinement, it is unavoidable not to use any triangular elements, which increases 
the stiffness of the model. It is then important to remove or not interpret the results from these 
triangular elements during the post-processing and evaluation. 
 

6.1.2 RBE3 
The automated RBE3 technique used is quick and effortless to perform and gives fairly good 
displacement results. However, the stress results do not fulfill the limits for approved result, and 
many of the tested cases are therefore not approved. The main reason for the bad result is that the 
global nodes are slaved to the local nodes, and not the opposite. Another reason is also that all 
weight factors are 1, independent of the relations between the nodes. This results in that the 
displacement in the slave node is calculated as the average of the master nodes, which is only true if 
the distance is equally large between the slave node and all master nodes. 
 
The automated method is especially sensitive to loads normal to the surface. As for all Global-Local 
techniques; the smaller difference in elements size of the global and local model, the smaller are the 
boundary effects.  
 
The automated technique requires a bit more effort from the user if both the local and global models 
consist of shell elements and have a complex geometry at the boundary. Furthermore, since the 
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boundary effects are quite large, it is important to ha a larger local model than what is used in the 
parametric study, so that the boundary effects will fade out before reaching the area of interest.  
 
The manual method of defining RBE3 elements gives results more close to the reference values. A 
big disadvantage of the manual method is that it is time consuming and messy for models with 
many nodes, this could however be solved by writing a new script that creates RBE3 elements 
according to the manual method. 
 
It is important to notice that the definition of the RBE3 elements created by the automated 
technique differs from the standard usage of RBE3 elements for Global-Local techniques that was 
used in the manual method. Both when looking at weight factors, connected nodes and which nodes 
are dependent and independent respectively. The settings have a huge influence of the results and 
the reader is strongly recommended to perform tests on a smaller model before implementing RBE3 
on the real detail. The settings depend on the geometry, how the RBE3 elements are placed and also 
of how the loads are applied. 
 

6.1.3 Glue 
The results from the test cases of Glue methods indicate that Glue works well for connections of 
both Shell-To-Shell and Shell-To-Solid. However, it is very sensitive to offsets and gaps between 
the local and global model. If there is a gap in between the global and local model, this cannot be 
larger than approximately 0.05 % of the shell thickness. The glue method works for in plane loads 
but does not work at all for load case Force_z which is causing a bending moment. 
 
Since the tolerance region is defined normal to the contact section, it is not possible to use this 
method for offsets that are normal to the shell, in this case the z-direction, if both the global and 
local model are built of shell elements. This is basically the case also when the local model consists 
of solid elements. However, if the offset is within the thickness of the solid, the nodes can still be 
glued. 
 
When a gap or overlap is present between the global and local model, it is usually better to retain 
the gap, instead of try to glue them together which can cause unnecessary big stresses and 
deformations. 
 
A disadvantage of this method is how it is implemented in MSC Patran; the contact table where 
Glue is defined has to be defined separately for each load case. If there are many load cases this is 
very time consuming. One way to work around this is to define the contact table manually in the 
.bdf file or to create a script that does this automatically. 
 

6.1.4 DMIG 
The DMIG method only works when the meshes are compatible, which is a big limitation of the 
method. However it is an effective way to break down the problem into smaller pieces and could 
therefore be used in combination with other methods to achieve good local results with a fine mesh. 
 
The results of the different DMIG tests can not be directly compared with each other since in one of 
the cases, a mesh refinement is performed on the global model. However; the results indicate that 
the two methods are equivalent.  
 
DMIG could also be used with Glue if that should be advantageous. 
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6.1.5 Comparison of methods 
All tested methods in the parametric study are compared in Table 6.1, where it is possible to see 
which method is approved for which test case and load. If only the load case is studied the RBE3 
method is preferred for all load cases. Most of the test cases are also preferred to be analysed with 
the RBE3 method, except Case 1 where mesh refinement or DMIG are preferable, Case 2 where 
glue has the same number of approved load cases and 4c where glue is better. 
 

Table 6.1: Comparison of all cases. 1 and colour indicates approved results in the parametric study 
and 0 is unapproved. Mesh refinement (m) is represented with orange, Glue (G) is represented 

with yellow, automated RBE3 (R) with green and DMIG (D) with blue. The method with highest 
number of approved cases are marked with a bold number 

Case no Force_x Force_y Force_z Central_y # approved 
  m g R D m g R D m g R D m g R D m g R D 
1 1 1 0 1 1 1 0 1 1 0 0 1 1 1 0 1 4 3 0 4 
2 0 1 1 0 0 1 1 0 0 0 0 0 0 1 1 0 0 3 3 0 

3a 0 0 1 0 0 0 1 0 0 0 1 0 0 0 1 0 0 0 4 0 
3b 0 0 1 0 0 0 1 0 0 0 1 0 0 0 0 0 0 0 3 0 
3c 0 0 1 0 0 0 1 0 0 0 1 0 0 0 1 0 0 0 4 0 
3d 0 0 1 0 0 0 1 0 0 0 1 0 0 0 1 0 0 0 4 0 
3e 0 0 1 0 0 0 1 0 0 0 1 0 0 0 1 0 0 0 4 0 
3f 0 0 1 0 0 0 1 0 0 0 1 0 0 0 1 0 0 0 4 0 
3g 0 1 1 0 0 1 1 0 0 0 1 0 0 1 1 0 0 3 4 0 
4a 0 0 1 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 3 0 
4b 0 0 1 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 2 0 
4c 0 1 1 0 0 0 0 0 0 0 0 0 0 1 0 0 0 2 1 0 
4d 0 0 1 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 3 0 
4e 0 0 0 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 2 0 
4f 0 0 1 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 3 0 
4g 0 0 1 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 3 0 

# approved 1 4 14 1 1 3 14 1 1 0 7 1 1 4 12 1      
 
Table 6.2 shows the approved percentage of possible approved cases, sorted per category. From this 
table it is possible to see that Glue has a low percentage of approved cases, but there is no 
difference in number of approved for Shell-To-Shell or Shell-To-Solid couplings. Glue is sensitive 
to normal loads causing bending moments, and to geometry shortcomings. 
 
It is also clear that RBE3 works better for Shell-To-Shell coupling than Shell-To-Solid, and is also 
sensitive to normal loads causing bending moments. RBE3 can handle most of the geometry 
shortcomings, but has a higher approved percentage for gaps in the plane. 
 
The definition of DMIG is that it only works when the node positions are exact, and the total 
numbers of possible cases are lower than for Glue and RBE3. DMIG is approved for all load cases, 
but has to be combined with another method for the Global-Local coupling. 
 
As for DMIG, also mesh refinement has a lower number of possible cases, since it is only tested for 
a case corresponding to Case 1. Mesh refinement is approved for this case. 
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Table 6.2: Approved percentage of possible approved cases sorted per category. The total number 
of possible cases are decreased for mesh refinement and DMIG due to that it is only tested for Case 

1 or corresponding, categories with out results are marked with - 

 Mesh 
refinement Glue RBE3 

(automated) 
RBE3 
(manual) DMIG 

Shell-To-Shell 100 19 84 100 100 
Shell-To-Solid - 19 63 - - 
In plane loads 100 23 83 100 100 
Normal loads 100 0 44 50 100 
Geometry offsets (z-
direction) - 25 63 - - 

Geometry gaps (in plane) - 6 81 - - 
 
It is also important to consider that the total criterion score have to be larger than the global score. A 
summary of cases that are approved and have higher score than the global model is found in 
Appendix B Results from Parametric Study, Table B. 9. It is here shown that a majority of the cases 
for Force_y have lower values than the global score. 
 
Figure 6.1 shows a bar chart over the total criteria scores for all load cases, see Appendix B - 
Results from Parametric Study for further charts, sorted per load case. For a comparison of the 
methods average total criteria scores for each method is calculated for each category and presented 
in Table 6.3. It is important to note that mesh refinement and DMIG is not viable for all test cases 
and is therefore given a higher total average. 
 

Table 6.3: Average total criterion score per category, categories with out results are marked with - 

 Mesh 
refinement Glue RBE3 

(automated) 
RBE3 
(manual) DMIG 

Shell-To-Shell 0.86 0.34 0.94 0.96 0.98 
Shell-To-Solid - 0.22 0.85 0.89 - 
In plane loads 0.99 0.29 0.93 0.96 0.97 
Normal loads 1.00 0.24 0.80 0.82 0.99 
Geometry offsets (z-direction) - 0.42 0.90 - - 
Geometry gaps (in plane) - 0.14 0.91 - - 
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Figure 6.1: Total criteria scores for all methods and load cases 
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6.2 Evaluation of Gripen Test Study 
The results indicate that if possible, it is better to connect the attachment to the local model of the 
wall with Glue than with RBE3, to avoid local effects at the wall. However, if the effects from the 
bolts are the main interest, this should be modelled in another way. The transition within the local 
model is not the main interest in this study and therefore not investigated further in this thesis. 
 
The results also shows that the use of RBE3 to connect a local solid model to a global shell model 
gives results closer to the reference value than if mesh refinement is used on the shell elements in 
the global model. When modelling with solid elements it is possible to see effects that will not be 
shown if only shell models are used, for example the stress field at a radius on a beam. 
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CHAPTER 7  
DISCUSSION 

 
 
In this chapter all results are discussed and the author’s opinions are also stated here. All methods 
are discussed without any consideration whether the particular software used is the most suitable 
for the specific method or not, the methods are, however, discussed with respect to the used 
software for each method. 
 
The influence of the solver is not evaluated in this thesis. It is however important to note that all 
methods are not solved in the same software which can result in some deviations due to the used 
software. 
 
It is the author’s opinion that the least complicated method to perform, of the evaluated methods in 
this thesis, is the automated script in HyperWorks that creates RBE3 element to connect the local 
model to the global model. Both the generic test model and the test model from Gripen have fairly 
simple geometry and the method is probably more complicated for a complex geometry. This 
method is however not giving desired results for the stresses, due to the bad settings of the elements 
as discussed in previous chapter. 
 
When comparing the two different RBE3 methods, it is clear that the manual method is more 
appropriate, however, if only the displacements are in interest it is possible to use the automated 
script with almost as good results as for the manual method. 
 
If the file size is too large to evaluate due to the increase of number of elements within the local 
model; DMIG or another corresponding superelement technique, can be used just outside the 
boundary between the global and local model, as in the parametric study. 
 
If possible, it is preferable to use mesh refinement closest to the boundary between the local and 
global model. It is however not a method that is largely useful as an independent Global-Local 
method for large scale models due to the large increased in demand for computing power. 
 
DMIG is a useful method to decrease the file size and demand for computing power. Since this 
method only works when the nodes on the boundary is placed in the same node position as in the 
global model, it has to be combined with another method for the Global-Local connection. 
 
Glue is a good method to use to glue surfaces upon each other instead of side contact as tested in the 
parametric study. If for example an attachment is modelled it can be connected to the rest of the 
model with glue instead of other interface elements. 
 
Many of the methods tested here can also be used in other types of applications. For example RBE3 
could be used as an interface between a global and local model where the RBE3 represents for 
example bolts. In this case, the implementation differs from the Global-Local technique discussed in 
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this thesis, where the Global-Local connection represents a continuous model. The degrees of 
freedom could probably be defined only with translations due to that it is not desirable to model 
them as moment carrying bolts. 
 
An overall issue for Global-Local techniques is the importance of having a sufficiently large local 
area, so that the boundary effects have faded before reaching the area of interest. A useful rule to 
use when designing the FE-model is that the distance from the boundary to the area of interest 
should be at least the same length as the largest dimension of the side where the load is applied. It is 
also important to have smaller elements closest to the boundary, also on the global model if 
possible. 
 
A big limitation in all the method tested in this master thesis is that all are performed with linear 
analysis. Since the forces in the generic model are fairly small, the effects are not that big. However, 
in a real case scenario, the forces applied normal to the surface can be much bigger, which increase 
the demand for non-linear analysis where for example membrane stresses can be handled. For an 
integrated Global-Local analysis it is, per definition, not possible to perform non-linear analysis on 
only the local model. The whole model has to be modeled and analyzed with non-linear 
assumptions and this increases the demand for computational power drastically. Alternative, it is 
possible to us a superelement technique or similar, which is however not verified or tested in this 
master thesis. 
 

7.1 Recommendation of Method 
The global model of Gripen is today modelled with superelements reminiscent of DMIG. The 
superelement including the area of interest can be extracted from the global model of Gripen and 
used as an independent global model. Depending on the loads acting on the area of interest, the 
boundary conditions are applied differently. Instead of applying boundary conditions the overall 
global model for Gripen can also be used in a two levelled superelement technique. A two levelled 
superelement technique is preferable when there are loads travelling through the boundary, for 
example when a big load is applied just outside the global model. 
 
For most of the cases, the local area of interest is then preferable modelled with solid elements 
attached to the global model with RBE3 in the same way as the manual method. The local area has 
to be bigger than in the parametric study, to avoid boundary effects within the area of interest. 
RBE3 is optimal when the models are compatible and large differences on the boundary between 
the global and local model should therefore be avoided. If boundary differences still are presents, 
RBE3 is the best method to deal with this, but the size of the local model is even more important. 
 
To reduce the boundary effects, mesh refinement can be performed on both the local and global 
model where it is possible. However; this is not mandatory, it only reduces the needed size of the 
local model.  
 
If there is a Global-Local connection between the normal of two surfaces, instead of edge 
connection as tested in the parametric study, both Glue and RBE3 can be used. However, the 
models have to be geometric compatible to be able to use Glue. 
 
If the user is unsure of the methods and all settings, it is always a good idea to make a simple test 
model first, on which the method can be tested before implementing on the real detail. Important to 
investigate is especially the weight factors and degrees of freedom for the RBE3. The weight factors 
that are to be used strongly depend on the model, and are therefore not the same as for different 
models. 
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CHAPTER 8  
FUTURE WORK 

 
 
In this chapter a few suggestions of future work are stated. This thesis should be regarded as a 
preliminary study and further investigation is recommended. 
 
As described previous in this thesis, the software are not evaluated, and the desired method should 
therefore be investigated for several software before choosing software. Further investigations are 
also recommended on the chosen method, since the testes preformed here are of a quite simple 
nature. At least one test should be preformed on a model with a more complex geometry than the 
ones used here. 
 
Another suggestion of future work is to look closer to the DMIG method. According to staff at 
MSC, this method is possible to use for non-linear analysis but with linear boundary conditions. 
This is not tested in this thesis, but can be a good method to combine with for example RBE3 for a 
more accurate analysis in the local model.  
 
According to the results in this thesis, the RBE3 elements works best when the local nodes are 
slaved to the global nodes and with weight factors calculated with respect to the geometry. It is 
therefore the author’s recommendations to write a new script that creates RBE3 elements according 
to the manual method tested in this thesis. This method used for RBE3 in HyperMesh can also be 
implemented in for example MSC Patran/Nastran. However corresponding scrip to the one used in 
HyperMesh has to be written. One alternative to RBE3 in MSC Patran/Nastran is to use RSSCON 
which is an element specially adapted for Shell-To-Solid coupling.  
 
If both the global and local model consists of shell elements, the scripts, both in HyperMesh and 
MSC Patran/Nastran, can advantageously be modified with respect to the degrees of freedom, since 
different settings are used for different types of connections. 
 
The transition between shell elements to bar elements or solid elements to bar elements are not 
investigated in a large scale in this thesis. So some extra test could be preformed on a generic model 
with a beam through the local model, to investigate the behavior of this type of connection. 
 
Another area to look closer into is the importance of element size at the boundary between the local 
and global model. What is the optimum size of an element at the boundary to reduce the boundary 
effects from the Global-Local coupling? 
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APPENDIX A 
MATLAB SCRIPT FOR EVALUATION OF THE 

PARAMETRIC STUDY 
 

 
This appendix contains the MATLAB scripts used to evaluate the parametric study. Only the code 
for displacement results is presented here, however, the code for the stress results has the same 
structure. The main results file, disp_results_main.m calls two functions; plot_disp.m and 
crit_disp.m. Plot_disp.m creates graphs of the displacement compared to the reference values and 
global model and crit_disp.m calculates the criterion scores and plots the results of the scores. 
Disp_results_main.m is here shortened but it produces results in the same way as for glue Case 1 
for the remaining sub-cases. 
 

A.1 disp_results_main.m 
% This program creates displacement results plots for all results 
% files in the parametric study. It is a part of the  
% master thesis "Method Evaluation of Global-Local  
% Finite Element Analysis" performed at Linköping  
% Universiy for Saab Aeronautics, 2012. 
%  
% (c) Gabriella Ahlbert 2012 
% 
% The results files (.mat) are created with read_results.m 
% and have following structure: 
% Node ID         = results(:,1) 
% x-coordinate    = results(:,2) 
% y-coordinate    = results(:,3) 
% z-coordinate    = results(:,4) 
% displacement    = results(:,5)(in the same direction as the load) 
% stress          = results(:,6) 
% 
%% Reference values 
clf; clear all; close all; clc; 
  
load('ref.mat') 
x           = ref_FX(:,2); 
disp_FX     = ref_FX(:,5); 
disp_FY     = ref_FY(:,5); 
disp_FZ     = ref_FZ(:,5); 
disp_CY     = ref_CY(:,5); 
ref_values  = [x disp_FX disp_FY disp_FZ disp_CY]; 
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n=1;figure(n);n=n+1; 
plot(x,disp_FX,'r-') 
xlabel('x-position'); 
ylabel('Displacement [mm] x-direction'); 
title('Ref. values Force x'); 
legend('Ref. values'); 
axis([0 100 min(disp_FX) max(disp_FX)]); 
  
figure(n);n=n+1; 
plot(x,disp_FY,'r-') 
xlabel('x-position'); 
ylabel('Displacement [mm] y-direction'); 
title('Ref. values Force y'); 
legend('Ref. values'); 
axis([0 100 min(disp_FY) max(disp_FY)]); 
  
figure(n);n=n+1; 
plot(x,disp_FZ,'r-') 
xlabel('x-position'); 
ylabel('Displacement [mm] z-direction'); 
title('Ref. values Force z'); 
legend('Ref. values'); 
axis([0 100 min(disp_FZ) max(disp_FZ)]); 
  
figure(n);n=n+1; 
plot(x,disp_CY,'r-') 
xlabel('x-position'); 
ylabel('Displacement [mm] y-direction'); 
title('Ref. values Central y'); 
legend('Ref. values'); 
axis([0 100 min(disp_CY) max(disp_CY)]); 
  
%% Plot global values 
load('global.mat') 
x               = global_FX(:,2); 
disp_FX         = global_FX(:,5); 
disp_FY         = global_FY(:,5); 
disp_FZ         = global_FZ(:,5); 
disp_CY         = global_CY(:,5); 
global_values   = [x disp_FX disp_FY disp_FZ disp_CY]; 
  
figure(n);n=n+1; 
plot(ref_values(:,1),ref_values(:,2),'r-',x,disp_FX,'b:') 
xlabel('x-position'); 
ylabel('Displacement [mm] x-direction'); 
title('Force x'); 
legend('Ref. values','Global values'); 
axis([0 100 min(min(disp_FX),min(ref_values(:,2)))... 
    max(max(disp_FX),max(ref_values(:,2)))]); 
  
figure(n);n=n+1; 
plot(ref_values(:,1),ref_values(:,3),'r-',x,disp_FY,'b:') 
xlabel('x-position'); 
ylabel('Displacement [mm] y-direction'); 
title('Force y'); 
legend('Ref. values','Global values'); 
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axis([0 100 min(min(disp_FY),min(ref_values(:,3)))... 
    max(max(disp_FY),max(ref_values(:,3)))]); 
  
figure(n);n=n+1; 
plot(ref_values(:,1),ref_values(:,4),'r-',x,disp_FZ,'b:') 
xlabel('x-position'); 
ylabel('Displacement [mm] z-direction'); 
title('Force z'); 
legend('Ref. values','Global values'); 
axis([0 100 min(min(disp_FZ),min(ref_values(:,4)))... 
    max(max(disp_FZ),max(ref_values(:,4)))]); 
  
figure(n);n=n+1; 
plot(ref_values(:,1),ref_values(:,5),'r-',x,disp_CY,'b:') 
xlabel('x-position'); 
ylabel('Displacement [mm] y-direction'); 
title('Central y'); 
legend('Ref. values','Global values'); 
axis([0 100 min(min(disp_CY),min(ref_values(:,5)))... 
    max(max(disp_CY),max(ref_values(:,5)))]); 
  
%Criterion in x=50 
for i=1:4 
    crit_REM(i) = max(0, 1-abs(ref_values(28,i+1)-
global_values(6,i+1))./abs(ref_values(28,i+1))); 
    crit_FEM(i) = max(0,ref_values(28,i+1).*global_values(6,i+1))./... 
            max(ref_values(28,i+1).^2, global_values(6,i+1).^2); 
    crit_comb(i) = (crit_REM(i)+crit_FEM(i))/2; 
end; 
global_crit = [crit_REM; crit_FEM; crit_comb]; 
  
%% Plot Mesh refinement values 
load('refinement.mat') 
x               = refinement_FX(:,2); 
disp_FX         = refinement_FX(:,5); 
disp_FY         = refinement_FY(:,5); 
disp_FZ         = refinement_FZ(:,5); 
disp_CY         = refinement_CY(:,5); 
refinement_values   = [x disp_FX disp_FY disp_FZ disp_CY]; 
 
plot_disp('Mesh refinement', [x disp_FX disp_FY disp_FZ disp_CY]); 
  
%Criterion in x=50 
for i=1:4 
    crit_REM(i) = max(0, 1-abs(ref_values(28,i+1)-
refinement_values(9,i+1))./abs(ref_values(28,i+1))); 
    crit_FEM(i) = 
max(0,ref_values(28,i+1).*refinement_values(9,i+1))./... 
            max(ref_values(28,i+1).^2, refinement_values(9,i+1).^2); 
    crit_comb(i) = (crit_REM(i)+crit_FEM(i))/2; 
end; 
refinement_crit = [crit_REM; crit_FEM; crit_comb]; 
  
%% Plot DMIG with mesh refinement values 
load('DMIG_refinement.mat') 
x               = DMIG_refinement_FX(:,2); 
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disp_FX         = DMIG_refinement_FX(:,5); 
disp_FY         = DMIG_refinement_FY(:,5); 
disp_FZ         = DMIG_refinement_FZ(:,5); 
disp_CY         = DMIG_refinement_CY(:,5); 
DMIG_refinement_values   = [x disp_FX disp_FY disp_FZ disp_CY]; 
  
plot_disp('DMIG with mesh refinement', [x disp_FX disp_FY disp_FZ 
disp_CY]); 
 
for i=1:4 
    crit_REM(i) = max(0, 1-abs(ref_values(28,i+1)-
DMIG_refinement_values(9,i+1))./abs(ref_values(28,i+1))); 
    crit_FEM(i) = 
max(0,ref_values(28,i+1).*DMIG_refinement_values(9,i+1))./... 
            max(ref_values(28,i+1).^2, 
DMIG_refinement_values(9,i+1).^2); 
    crit_comb(i) = (crit_REM(i)+crit_FEM(i))/2; 
end; 
DMIG_refinement_crit = [crit_REM; crit_FEM; crit_comb]; 
  
%% Plot DMIG with RBE3 values 
load('DMIG_RBE3.mat') 
x               = DMIG_RBE3_FX(:,2); 
disp_FX         = DMIG_RBE3_FX(:,5); 
disp_FY         = DMIG_RBE3_FY(:,5); 
disp_FZ         = DMIG_RBE3_FZ(:,5); 
disp_CY         = DMIG_RBE3_CY(:,5); 
DMIG_RBE3_values   = [x disp_FX disp_FY disp_FZ disp_CY]; 
  
plot_disp('DMIG with RBE3', [x disp_FX disp_FY disp_FZ disp_CY]); 
 
for i=1:4 
    crit_REM(i) = max(0, 1-abs(ref_values(28,i+1)-
DMIG_RBE3_values(9,i+1))./abs(ref_values(28,i+1))); 
    crit_FEM(i) = 
max(0,ref_values(28,i+1).*DMIG_RBE3_values(9,i+1))./... 
            max(ref_values(28,i+1).^2, DMIG_RBE3_values(9,i+1).^2); 
    crit_comb(i) = (crit_REM(i)+crit_FEM(i))/2; 
end; 
crit_REM 
crit_FEM 
crit_comb 
DMIG_RBE3_crit = [crit_REM; crit_FEM; crit_comb]; 
  
%% Plot Glue case1 values 
load('glue_case1.mat') 
x               = glue_case1_FX(:,2); 
disp_FX         = glue_case1_FX(:,5); 
disp_FY         = glue_case1_FY(:,5); 
disp_FZ         = glue_case1_FZ(:,5); 
disp_CY         = glue_case1_CY(:,5); 
glue_case1_values   = [x disp_FX disp_FY disp_FZ disp_CY]; 
plot_disp('RBE3 case1', [x disp_FX disp_FY disp_FZ disp_CY]); 
glue_case1_crit = crit_disp('Glue case1',[x disp_FX disp_FY disp_FZ 
disp_CY]);  
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A.2 plot_disp.m 
function plot_disp(name3,results3) 
% This function compares displacement resultplots in the  
% parametric study. It is a part of the master thesis "Method  
% Evaluation of Global-Local Finite Element Analysis"  
% performed at Linköping Universiy for Saab  
% Aeronautics, 2012. 
%  
% (c) Gabriella Ahlbert 2012 
%  
% Input: plot_results(name_results3, [results3]) 
% [results1] = [x,force_x,force_y,force_z,central_y] (Reference 
values) 
% [results2] = [x,force_x,force_y,force_z,central_y] (Global model) 
% [results3] = [x,force_x,force_y,force_z,central_y]  
%  
load('ref.mat') 
x           = ref_FX(:,2); 
disp_FX     = ref_FX(:,5); 
disp_FY     = ref_FY(:,5); 
disp_FZ     = ref_FZ(:,5); 
disp_CY     = ref_CY(:,5); 
results1    = [x disp_FX disp_FY disp_FZ disp_CY]; 
name1       = 'Ref. values'; 
  
load('global.mat') 
x           = global_FX(:,2); 
disp_FX     = global_FX(:,5); 
disp_FY     = global_FY(:,5); 
disp_FZ     = global_FZ(:,5); 
disp_CY     = global_CY(:,5); 
results2    = [x disp_FX disp_FY disp_FZ disp_CY]; 
name2       = 'Global values'; 
  
count = 1; 
for j=1:4 
    if j==1 
        direction = 'Displacement [mm] x-direction'; 
        load_case = 'Force x'; 
    elseif j==2 
        direction = 'Displacement [mm] y-direction'; 
        load_case = 'Force y'; 
    elseif j==3 
        direction = 'Displacement [mm] z-direction'; 
        load_case = 'Force z'; 
    else 
        direction = 'Displacement [mm] y-direction'; 
        load_case = 'Central y'; 
    end; 
     
    figure(count);count=count+1; 
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    plot(results1(:,1),results1(:,j+1),'r-',... 
        results2(:,1),results2(:,j+1),'b:',... 
        results3(:,1),results3(:,j+1),'g-.'); 
    xlabel('x-position') 
    ylabel(direction) 
    title(load_case) 
    legend(name1,name2,name3); 
     
    min_disp = min(min(min(results1(:,j+1)),min(results2(:,j+1))),... 
        min(results3(:,j+1))); 
    max_disp = max(max(max(results1(:,j+1)),max(results2(:,j+1))),... 
        max(results3(:,j+1))); 
    axis([0 100 min_disp max_disp]);    
end 
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A.3 crit_disp.m 
function crit = crit_disp(case_name,case_values) 
% This function is a part of the master thesis "Method  
% Evaluation of Global-Local Finite Element Analysis"  
% performed at Linköping Universiy for Saab Aeronautics, 2012. 
%  
% (c) Gabriella Ahlbert 2012 
% 
% The program creates a plot with the criterion errors for a 
% given load case. 
%  
% 
% crit = plot_diff(case_name,case_values) 
% case_values = [x force_x force_y force_z central_y] 
% crit = [crit_REM; crit_FEM; crit_total] 
  
% Defining weight factors 
W_REM = 1; 
W_FEM = 1; 
  
% Reading reference values 
load('ref.mat') 
x           = ref_FX(:,2); 
disp_FX     = ref_FX(:,5); 
disp_FY     = ref_FY(:,5); 
disp_FZ     = ref_FZ(:,5); 
disp_CY     = ref_CY(:,5); 
ref_values  = [x disp_FX disp_FY disp_FZ disp_CY]; 
ref_name    = 'Ref. values'; 
  
%Finding the local area x=[40-60] 
i=1;n=1; 
while n==1 
    if case_values(i,1)<= 40 
        local_min = i; 
    elseif case_values(i,1)>=60 
        local_max = i; 
        n=0; 
    end; 
    i=i+1; 
end; 
start = 21-local_min; 
  
fig_nr=100; 
for j=1:4 
    for i=21:31 
        crit_REM(i,1)   = ref_values(i,1); 
        crit_REM(i,j+1) = max(0, 1-abs(ref_values(i,j+1)-... 
            case_values(i-start,j+1))/abs(ref_values(i,j+1))); 
        crit_FEM(i,1)   = ref_values(i,1); 
        crit_FEM(i,j+1) = max(0, ref_values(i,j+1)*case_values(i-
start,j+1))/... 
            max(ref_values(i,j+1)^2,case_values(i-start,j+1)^2); 
        crit_tot(i,1)   = ref_values(i,1); 
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        crit_tot(i,j+1) = 
(W_REM*crit_REM(i,j+1)+W_FEM*crit_FEM(i,j+1))/(W_REM+W_FEM); 
    end; 
     
    if j==1 
        load_name = ' Force x'; 
    elseif j==2 
        load_name = ' Force y'; 
    elseif j==3 
        load_name = ' Force z'; 
    else 
        load_name = ' Central y'; 
    end; 
     
    figure(fig_nr) 
    fig_nr = fig_nr+1; 
    plot(crit_REM(21:31,1),crit_REM(21:31,j+1), 'r-',... 
         crit_FEM(21:31,1),crit_FEM(21:31,j+1), 'b:',... 
         crit_tot(21:31,1),crit_tot(21:31,j+1), 'g--') 
    xlabel('x-position') 
    ylabel('Criteria point, disp.') 
    title(horzcat(case_name,load_name)) 
    legend('Relative Error Method', 'Factor Error Method', 'Combined 
Error') 
    axis([42 56 0 1]) 
  
    
    %Criteria points between x=[44-56] 
    crit_REM_min(j)     = min(crit_REM(23:29,j+1)); 
    crit_FEM_min(j)     = min(crit_FEM(23:29,j+1)); 
    crit_tot_min(j)     = min(crit_tot(23:29,j+1)); 
end 
  
  
disp(case_name); 
disp('Criteria points (displacement), Relative Error Method:'); 
disp(crit_REM_min); 
disp('Criteria points (displacement), Factor Error Method:'); 
disp(crit_FEM_min); 
disp('Criteria points (displacement), combined points:'); 
disp(crit_tot_min); 
crit = [crit_REM_min; crit_FEM_min; crit_tot_min]; 
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APPENDIX B 
RESULTS FROM PARAMETRIC STUDY 

 
 
This appendix contains criterion scores from the parametric study. The connection scores have a 
one digit accuracy and the displacement and stress scores have a four- digit accuracy. 
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B.1 Connection scores 
Table B. 1: Score for criterion 1 - Connection 

Method and  case no Force_x Force_y Force_z Central_y 
global_coarse 1 1 1 1 
mesh_ refinement 1 1 1 1 
glue_case1 1 1 1 1 
glue_case2 1 1 1 1 
glue_case3a 0 0 0 0 
glue_case3b 0 0 0 0 
glue_case3c 0 0 0 0 
glue_case3d 0 0 0 0 
glue_case3e 0 0 0 0 
glue_case3f 0.5 0.5 0.5 0.5 
glue_case3g 1 1 1 1 
glue_case4a 0 0 0 0 
glue_case4b 0 0 0 0 
glue_case4c 1 1 1 1 
glue_case4d 0 0 0 0 
glue_case4e 0 0 0 0 
glue_case4f 0 0 0 0 
glue_case4g 0 0 0 0 
RBE3_case1 1 1 1 1 
RBE3_case2 1 1 1 1 
RBE3_case3a 1 1 1 1 
RBE3_case3b 1 1 1 1 
RBE3_case3c 1 1 1 1 
RBE3_case3d 1 1 1 1 
RBE3_case3e 1 1 1 1 
RBE3_case3f 1 1 1 1 
RBE3_case3g 1 1 1 1 
RBE3_case4a 1 1 1 1 
RBE3_case4b 1 1 1 1 
RBE3_case4c 1 1 1 1 
RBE3_case4d 1 1 1 1 
RBE3_case4e 1 1 1 1 
RBE3_case4f 1 1 1 1 
RBE3_case4g 1 1 1 1 
DMIG_ refinement 1 1 1 1 
DMIG_RBE3 1 1 1 1 
RBE3_case1_ manual 1 1 1 1 
RBE3_case2_ manual 1 1 1 1 
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B.2 Displacement scores 
Table B. 2: Score for criterion 2 – Displacement. Relative Error Method 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.9892 0.9513 0.9834 0.3512 
mesh_ refinement 0.9733 0.9976 0.9992 0.9595 
glue_case1 0.9908 0.9923 0.9891 0.9527 
glue_case2 0.9299 0.9715 0.8266 0.9541 
glue_case3a 0.9585 0.8843 0.0845 0.9492 
glue_case3b 0.9730 0.8843 0.0993 0.6432 
glue_case3c 0 0 0 0 
glue_case3d 0.9596 0.8902 0.0833 0.9414 
glue_case3e 0.9521 0.8843 0.0825 0.9336 
glue_case3f 0.9913 0.9929 0.9908 0.9555 
glue_case3g 0.9388 0.8843 0.0777 0.918 
glue_case4a 0.8745 0.8427 0.4624 0.9453 
glue_case4b 0.8875 0.8427 0.4768 0.6576 
glue_case4c 0.8562 0.8378 0.4524 0.9210 
glue_case4d 0.8724 0.8427 0.4614 0.9453 
glue_case4e 0.8670 0.8368 0.4608 0.9297 
glue_case4f 0 0.5169 0.4539 0.7031 
glue_case4g 0.70110 0.8071 0.4556 0.8906 
RBE3_case1 0.9557 0.9935 0.9932 0.7991 
RBE3_case2 0.9540 0.9932 0.9928 0.9885 
RBE3_case3a 0.9569 0.9982 0.9915 0.9902 
RBE3_case3b 0.9558 0.9976 0.9911 0.6487 
RBE3_case3c 0.9593 0.9625 0.9915 0.9793 
RBE3_case3d 0.9570 0.9964 0.9915 0.9916 
RBE3_case3e 0.9557 0.9935 0.9928 0.9914 
RBE3_case3f 0.9557 0.9935 0.9932 0.9914 
RBE3_case3g 0.9557 0.9935 0.9932 0.9914 
RBE3_case4a 0.9528 0.9982 0.9911 0.9866 
RBE3_case4b 0.9527 0.9976 0.9911 0.2867 
RBE3_case4c 0.9718 0.8408 0.9911 0.9657 
RBE3_case4d 0.9541 0.9961 0.9917 0.9899 
RBE3_case4e 0.8584 0.8938 0 0.9456 
RBE3_case4f 0.9540 0.9932 0.9928 0.9885 
RBE3_case4g 0.9540 0.9932 0.9928 0.9885 
DMIG_ refinement 0.9936 0.9982 0.9997 0.9362 
DMIG_RBE3 0.9848 0.9982 0.9913 0.9058 
RBE3_case1_manual 0.9633 0.9952 0.9987 0.9539 
RBE3_case2_ manual 0.9633 0.9941 0.9996 0.9446 
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Table B. 3: Score for criterion 2 – Displacement. Factor Method 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.9892 0.9535 0.9834 0.3512 
mesh_ refinement 0.9733 0.9976 0.9992 0.9611 
glue_case1 0.9908 0.9923 0.9893 0.9527 
glue_case2 0.9299 0.9715 0.8266 0.9541 
glue_case3a 0.9585 0.8843 0.5221 0.9492 
glue_case3b 0.9730 0.8843 0.5261 0.7370 
glue_case3c 0 0 0 0 
glue_case3d 0.9596 0.8902 0.5217 0.9414 
glue_case3e 0.9521 0.8843 0.5215 0.9336 
glue_case3f 0.9913 0.9929 0.9908 0.9555 
glue_case3g 0.9388 0.8843 0.5202 0.9180 
glue_case4a 0.8745 0.8427 0.6503 0.9453 
glue_case4b 0.8875 0.8427 0.6565 0.7449 
glue_case4c 0.8562 0.8378 0.6461 0.9268 
glue_case4d 0.8724 0.8427 0.6499 0.9453 
glue_case4e 0.8670 0.8368 0.6497 0.9297 
glue_case4f 0.1891 0.5169 0.6468 0.7031 
glue_case4g 0.7699 0.8071 0.6475 0.8906 
RBE3_case1 0.9557 0.9935 0.9932 0.8327 
RBE3_case2 0.9540 0.9932 0.9928 0.9885 
RBE3_case3a 0.9569 0.9982 0.9915 0.9902 
RBE3_case3b 0.9558 0.9976 0.9911 0.7400 
RBE3_case3c 0.9593 0.9625 0.9915 0.9793 
RBE3_case3d 0.9570 0.9965 0.9915 0.9917 
RBE3_case3e 0.9557 0.9935 0.9928 0.9914 
RBE3_case3f 0.9557 0.9935 0.9932 0.9914 
RBE3_case3g 0.9557 0.9935 0.9932 0.9914 
RBE3_case4a 0.9528 0.9982 0.9911 0.9866 
RBE3_case4b 0.9527 0.9976 0.9911 0.5771 
RBE3_case4c 0.9718 0.8408 0.9911 0.9669 
RBE3_case4d 0.9541 0.9962 0.9917 0.9900 
RBE3_case4e 0.8759 0.904 0.1932 0.9484 
RBE3_case4f 0.9540 0.9932 0.9928 0.9885 
RBE3_case4g 0.9540 0.9932 0.9928 0.9885 
DMIG_ refinement 0.9937 0.9982 0.9997 0.9400 
DMIG_RBE3 0.9848 0.9982 0.9914 0.9139 
RBE3_case1_manual 0.9633 0.9952 0.9987 0.9539 
RBE3_case2_manual 0.9633 0.9941 0.9996 0.9446 
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Table B. 4: Score for criterion 2 – Displacement. Combined score. 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.9892 0.9524 0.9834 0.3512 
mesh_ refinement 0.9733 0.9976 0.9992 0.9603 
glue_case1 0.9908 0.9923 0.9892 0.9527 
glue_case2 0.9299 0.9715 0.8266 0.9541 
glue_case3a 0.9585 0.8843 0.3033 0.9492 
glue_case3b 0.9730 0.8843 0.3127 0.6901 
glue_case3c 0 0 0 0 
glue_case3d 0.9596 0.8902 0.3025 0.9414 
glue_case3e 0.9521 0.8843 0.3020 0.9336 
glue_case3f 0.9913 0.9929 0.9908 0.9555 
glue_case3g 0.9388 0.8843 0.2989 0.9180 
glue_case4a 0.8745 0.8427 0.5563 0.9453 
glue_case4b 0.8875 0.8427 0.5666 0.7013 
glue_case4c 0.8562 0.8378 0.5493 0.9239 
glue_case4d 0.8724 0.8427 0.5557 0.9453 
glue_case4e 0.8670 0.8368 0.5552 0.9297 
glue_case4f 0.0946 0.5169 0.5504 0.7031 
glue_case4g 0.7355 0.8071 0.5516 0.8906 
RBE3_case1 0.9557 0.9935 0.9932 0.8159 
RBE3_case2 0.9540 0.9932 0.9928 0.9885 
RBE3_case3a 0.9569 0.9982 0.9915 0.9902 
RBE3_case3b 0.9558 0.9976 0.9911 0.6943 
RBE3_case3c 0.9593 0.9625 0.9915 0.9793 
RBE3_case3d 0.9570 0.9964 0.9915 0.9917 
RBE3_case3e 0.9557 0.9935 0.9928 0.9914 
RBE3_case3f 0.9557 0.9935 0.9932 0.9914 
RBE3_case3g 0.9557 0.9935 0.9932 0.9914 
RBE3_case4a 0.9528 0.9982 0.9911 0.9866 
RBE3_case4b 0.9527 0.9976 0.9911 0.4352 
RBE3_case4c 0.9718 0.8408 0.9911 0.9663 
RBE3_case4d 0.9541 0.9961 0.9917 0.9899 
RBE3_case4e 0.8672 0.8989 0.0966 0.9470 
RBE3_case4f 0.9540 0.9932 0.9928 0.9885 
RBE3_case4g 0.9540 0.9932 0.9928 0.9885 
DMIG_ refinement 0.9937 0.9982 0.9997 0.9381 
DMIG_RBE3 0.9848 0.9982 0.9913 0.9098 
RBE3_case1_manual 0.9633 0.9952 0.9987 0.9539 
RBE3_case2_manual 0.9633 0.9941 0.9996 0.9446 
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B.3 Stress scores 
 Table B. 5: Score for criterion 3 – Stress. Relative Error Method 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.6118 0.9644 0.9506 0.7559 
mesh_ refinement 0.9805 0.9969 0.9957 0.9943 
glue_case1 0.9800 0.9876 0.8644 0.9971 
glue_case2 0.9729 0.9610 0.6964 0.9608 
glue_case3a 0.4570 0.9226 0.6139 0.9263 
glue_case3b 0.4978 0.9294 0.4988 0.9413 
glue_case3c 0 0 0 0 
glue_case3d 0.6167 0.9106 0.6209 0.6415 
glue_case3e 0.7301 0.8937 0.6299 0.9041 
glue_case3f 0.9581 0.9890 0.8956 0.9961 
glue_case3g 0.9757 0.8959 0.7162 0.9073 
glue_case4a 0.4147 0.8759 0.9121 0.8758 
glue_case4b 0.4517 0.8806 0.7945 0.8839 
glue_case4c 0.8967 0.7851 0.6435 0.8396 
glue_case4d 0.5029 0.8317 0.3418 0.7918 
glue_case4e 0.6657 0.8494 0.3480 0.8563 
glue_case4f 0.8757 0 0.1244 0 
glue_case4g 0.9122 0 0.8244 0 
RBE3_case1 0.5222 0.5162 0.7623 0.5296 
RBE3_case2 0.9245 0.9230 0.2511 0.9162 
RBE3_case3a 0.8709 0.8684 0.9185 0.8794 
RBE3_case3b 0.8771 0.9121 0.9341 0.9232 
RBE3_case3c 0.8966 0.9089 0.9879 0.8885 
RBE3_case3d 0.8990 0.9429 0.9636 0.9354 
RBE3_case3e 0.9048 0.9230 0.9784 0.9141 
RBE3_case3f 0.9055 0.9210 0.9810 0.9126 
RBE3_case3g 0.9055 0.9210 0.9818 0.9126 
RBE3_case4a 0.8183 0.8661 0.2602 0.8787 
RBE3_case4b 0.8420 0.8934 0.2611 0.9110 
RBE3_case4c 0.9302 0.7998 0.1027 0.7706 
RBE3_case4d 0.8495 0.9437 0.2564 0.9368 
RBE3_case4e 0.8506 0.8918 0 0.8586 
RBE3_case4f 0.9241 0.9230 0.2512 0.9162 
RBE3_case4g 0.9245 0.9230 0.2511 0.9162 
DMIG_ refinement 0.9987 0.9988 0.999 0.9986 
DMIG_RBE3 0.8882 0.9283 0.9482 0.9324 
RBE3_case1_manual 0.9970 0.9969 0.8812 0.9950 
RBE3_case2_manual 0.9955 0.9961 0.2689 0.9921 
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Table B. 6: Score for criterion 3 – Stress. Factor Method 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.6118 0.9657 0.9529 0.7559 
mesh_ refinement 0.9805 0.9969 0.9957 0.9943 
glue_case1 0.9804 0.9876 0.8644 0.9971 
glue_case2 0.9729 0.9610 0.6964 0.9608 
glue_case3a 0.4570 0.9226 0.7215 0.9263 
glue_case3b 0.4978 0.9294 0.6662 0.9413 
glue_case3c 0 0 0 0 
glue_case3d 0.6167 0.9106 0.7251 0.6415 
glue_case3e 0.7301 0.8937 0.7299 0.9041 
glue_case3f 0.9598 0.9890 0.8956 0.9961 
glue_case3g 0.9757 0.8959 0.7789 0.9073 
glue_case4a 0.4147 0.8759 0.9192 0.8758 
glue_case4b 0.4517 0.8806 0.8295 0.8839 
glue_case4c 0.8967 0.7851 0.6435 0.8396 
glue_case4d 0.5029 0.8317 0.6031 0.7918 
glue_case4e 0.6657 0.8494 0.6053 0.8563 
glue_case4f 0.8757 0 0.5332 0 
glue_case4g 0.9122 0 0.8244 0 
RBE3_case1 0.5222 0.5162 0.7623 0.5296 
RBE3_case2 0.9245 0.9230 0.2511 0.9162 
RBE3_case3a 0.8857 0.8837 0.9247 0.8924 
RBE3_case3b 0.8905 0.9192 0.9382 0.9287 
RBE3_case3c 0.9063 0.9089 0.9880 0.8885 
RBE3_case3d 0.9082 0.9429 0.9649 0.9354 
RBE3_case3e 0.9131 0.9230 0.9788 0.9141 
RBE3_case3f 0.9137 0.9210 0.9813 0.9126 
RBE3_case3g 0.9137 0.9210 0.9822 0.9126 
RBE3_case4a 0.8183 0.8819 0.2602 0.8918 
RBE3_case4b 0.8420 0.9037 0.2611 0.9183 
RBE3_case4c 0.9302 0.7998 0.1027 0.7706 
RBE3_case4d 0.8495 0.9437 0.2564 0.9368 
RBE3_case4e 0.8700 0.9024 0 0.8761 
RBE3_case4f 0.9241 0.9230 0.2512 0.9162 
RBE3_case4g 0.9245 0.9230 0.2511 0.9162 
DMIG_ refinement 0.9987 0.9988 0.9990 0.9986 
DMIG_RBE3 0.8995 0.9283 0.9482 0.9324 
RBE3_case1_manual 0.9970 0,9969 0.8812 0.9950 
RBE3_case2_manual 0.9955 0.9961 0.2689 0.9921 
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Table B. 7: Score for criterion 3 – Stress. Combined score. 

Method and case no Force_x Force_y Force_z Central_y 
global_coarse 0.6118 0.9650 0.9518 0.7559 
mesh_refinement 0.9805 0.9969 0.9957 0.9943 
glue_case1 0.9802 0.9876 0.8644 0.9971 
glue_case2 0.9729 0.9610 0.6964 0.9608 
glue_case3a 0.4570 0.9226 0.6677 0.9263 
glue_case3b 0.4978 0.9294 0.5825 0.9413 
glue_case3c 0 0 0 0 
glue_case3d 0.6167 0.9106 0.6730 0.6415 
glue_case3e 0.7301 0.8937 0.6799 0.9041 
glue_case3f 0.959 0.9890 0.8956 0.9961 
glue_case3g 0.9757 0.8959 0.7476 0.9073 
glue_case4a 0.4147 0.8759 0.9156 0.8758 
glue_case4b 0.4517 0.8806 0.8120 0.8839 
glue_case4c 0.8967 0.7851 0.6435 0.8396 
glue_case4d 0.5029 0.8317 0.4724 0.7918 
glue_case4e 0.6657 0.8494 0.4767 0.8563 
glue_case4f 0.8757 0 0.3288 0 
glue_case4g 0.9122 0 0.8244 0 
RBE3_case1 0.5222 0.5162 0.7623 0.5296 
RBE3_case2 0.9245 0.9230 0.2511 0.9162 
RBE3_case3a 0.8783 0.8761 0.9216 0.8859 
RBE3_case3b 0.8838 0.9157 0.9361 0.9259 
RBE3_case3c 0.9015 0.9089 0.9879 0.8885 
RBE3_case3d 0.9036 0.9429 0.9642 0.9354 
RBE3_case3e 0.9090 0.9230 0.9786 0.9141 
RBE3_case3f 0.9096 0.9210 0.9811 0.9126 
RBE3_case3g 0.9096 0.9210 0.9820 0.9126 
RBE3_case4a 0.8183 0.8740 0.2602 0.8852 
RBE3_case4b 0.8420 0.8985 0.2611 0.9146 
RBE3_case4c 0.9302 0.7998 0.1027 0.7706 
RBE3_case4d 0.8495 0.9437 0.2564 0.9368 
RBE3_case4e 0.8603 0.8971 0 0.8673 
RBE3_case4f 0.9241 0.9230 0.2512 0.9162 
RBE3_case4g 0.9245 0.9230 0.2511 0.9162 
DMIG_ refinement 0.9987 0.9988 0.9990 0.9986 
DMIG_RBE3 0.8938 0.9283 0.9482 0.9324 
RBE3_case1_manual 0.9970 0.9969 0.8812 0.9950 
RBE3_case2_manual 0.9955 0.9961 0.2689 0.9921 
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B.4 Total scores 
Table B. 8: Total score 

Method and case no Force_x Force_y Force_z Central_y 
reference 1 1 1 1 
global_coarse 0.8404 0.9669 0.9740 0.6428 
mesh_refinement 0.9815 0.9978 0.9979 0.9818 
glue_case1 0.9884 0.9919 0.9414 0.9799 
glue_case2 0.9611 0.9730 0.8092 0.9659 
glue_case3a 0 0 0 0 
glue_case3b 0 0 0 0 
glue_case3c 0 0 0 0 
glue_case3d 0 0 0 0 
glue_case3e 0 0 0 0 
glue_case3f 0.8801 0.8927 0.8545 0.8806 
glue_case3g 0.9658 0.9120 0.6186 0.9301 
glue_case4a 0 0 0 0 
glue_case4b 0 0 0 0 
glue_case4c 0.9011 0.8491 0.6771 0.9054 
glue_case4d 0 0 0 0 
glue_case4e 0 0 0 0 
glue_case4f 0 0 0 0 
glue_case4g 0 0 0 0 
RBE3_case1 0.7911 0.8038 0.9022 0.7382 
RBE3_case2 0.9514 0.9664 0.6975 0.9618 
RBE3_case3a 0.9340 0.9497 0.9652 0.9504 
RBE3_case3b 0.9358 0.9653 0.9708 0.8480 
RBE3_case3c 0.9443 0.9485 0.9917 0.9471 
RBE3_case3d 0.9442 0.9757 0.9822 0.9708 
RBE3_case3e 0.9458 0.9666 0.9885 0.9622 
RBE3_case3f 0.9461 0.9658 0.9897 0.9616 
RBE3_case3g 0.9461 0.9658 0.9900 0.9616 
RBE3_case4a 0.9084 0.9488 0.7005 0.9487 
RBE3_case4b 0.9178 0.9584 0.7008 0.7399 
RBE3_case4c 0.9608 0.8562 0.6375 0.8947 
RBE3_case4d 0.9214 0.9759 0.6992 0.9706 
RBE3_case4e 0.8910 0.9184 0.2386 0.9257 
RBE3_case4f 0.9512 0.9664 0.6976 0.9618 
RBE3_case4g 0.9514 0.9664 0.6975 0.9618 
DMIG_ refinement 0.9969 0.9988 0.9994 0.9746 
DMIG_RBE3 0.9514 0.9706 0.9758 0.9368 
RBE3_case1_manual 0.9841 0.9968 0.9520 0.9796 
RBE3_case2_manual 0.9835 0.9961 0.7074 0.9747 
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Total criteria score, Force_x
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Figure B. 1: Total criteria scores for Force_x and all methods 
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Figure B. 2: Total criteria scores for Force_y and all methods 
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Total criteria score, Force_z
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Figure B. 3: Total criteria scores for Force_z and all methods 
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Figure B. 4: Total criteria scores for Force_x and all methods 
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Table B. 9: Approved and better than global? Cases that are approved and have higher total score 
than the global model are marked with 1 (green), and cases that are approved but have lower total 

score than the global model are marked with -1 (red). Unapproved cases are marked with 0 

Case nr Force_x Force_y Force_z Central_y 
reference 1 1 1 1 
global_coarse 0 -1 -1 0 
mesh_refinement 1 1 1 1 
glue_case1 1 1 -1 1 
glue_case2 1 1 0 1 
glue_case3a 0 0 0 0 
glue_case3b 0 0 0 0 
glue_case3c 0 0 0 0 
glue_case3d 0 0 0 0 
glue_case3e 0 0 0 0 
glue_case3f 0 0 0 0 
glue_case3g 1 -1 0 1 
glue_case4a 0 0 0 0 
glue_case4b 0 0 0 0 
glue_case4c 1 0 0 1 
glue_case4d 0 0 0 0 
glue_case4e 0 0 0 0 
glue_case4f 0 0 0 0 
glue_case4g 0 0 0 0 
RBE3_case1 0 0 0 0 
RBE3_case2 1 -1 0 1 
RBE3_case3a 1 -1 -1 1 
RBE3_case3b 1 -1 -1 0 
RBE3_case3c 1 -1 1 1 
RBE3_case3d 1 1 1 1 
RBE3_case3e 1 -1 1 1 
RBE3_case3f 1 -1 1 1 
RBE3_case3g 1 -1 1 1 
RBE3_case4a 1 -1 0 1 
RBE3_case4b 1 -1 0 0 
RBE3_case4c 1 0 0 0 
RBE3_case4d 1 1 0 1 
RBE3_case4e 0 -1 0 1 
RBE3_case4f 1 -1 0 1 
RBE3_case4g 1 -1 0 1 
DMIG_refinement 1 1 1 1 
DMIG_RBE3 1 1 1 1 
RBE3_case1_manual 1 1 -1 1 
RBE3_case2_manual 1 1 0 1 
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APPENDIX C 
RESULTS FROM GRIPEN TEST STUDY 

 
 
This appendix contains pictures of the results from Gripen Test Study, explained in Chapter 5. 
 

C.1 Global Results 

  
Figure C. 1: Stress (left) and displacements (right) results for load case 1, global model. Stresses 

from the top: con Mises, shear stress. Displacements from the top; x, y, z. 
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Figure C. 2: Stress (left) and displacements (right) results for load case 2, global model. Stresses 

from the top: con Mises, shear stress. Displacements from the top; x, y, z. 

 

 
Figure C. 3: Stress (left) and displacements (right) results for load case 3, global model. Stresses 

from the top: con Mises, shear stress. Displacements from the top; x, y, z. 
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C.2 Results from Mesh Refinement 

  
Figure C. 4: Stress (left) and displacements (right) results for load case 1, mesh refinement. 

Stresses from the top: con Mises, shear stress. Displacements from the top; x, y, z. 

  
Figure C. 5: Stress (left) and displacements (right) results for load case 2, mesh refinement. 

Stresses from the top: con Mises, shear stress. Displacements from the top; x, y, z. 
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Figure C. 6: Stress (left) and displacements (right) results for load case 3, mesh refinement. 

Stresses from the top: con Mises, shear stress. Displacements from the top; x, y, z. 
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C.3 Results from RBE3 

  
Figure C. 7: Stress (left) and displacements (right) results for load case 1, RBE3. Stresses from the 

top: con Mises, shear stress. Displacements from the top; x, y, z. 

 

  
Figure C. 8: Stress (left) and displacements (right) results for load case 2, RBE3. Stresses from the 

top: con Mises, shear stress. Displacements from the top; x, y, z. 
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Figure C. 9: Stress (left) and displacements (right) results for load case 3, RBE3. Stresses from the 

top: con Mises, shear stress. Displacements from the top; x, y, z. 
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APPENDIX D 
USER GUIDE TO USED METHODS 

 
 
This appendix is a user guide for the Global-Local methods used in this thesis; Mesh refinement, 
RBE3, Glue and DMIG Mesh refinement and RBE3 is described for HyperMesh, whereas Glue and 
DMIG is described for MSC Patran and Nastran. 
 

D.1 Mesh Refinement 
Mesh Refinement is implemented in HyperMesh 11.0 according to the steps below. RADIOSS 11.0 
is used as solver and HyperView 11.0 as post-processor. 
 

1. Create global model in HyperMesh.  

2. Click Mesh > Edit > Elements > Split Elements, and chose Refine elements. Mark the 
elements to be refined, closest to the local model, and chose the target element size. 

3. Define properties, loads and boundary conditions. 

4. Run the analysis 

 

D.2 RBE3 
Before implementing RBE3 elements it is important to consider the desired settings, for master and 
slaved nodes as well as degrees of freedom and weighting factors. RBE3 uses weighting factors 
between the slaves and master nodes, the force distribution in the slave nodes is calculated with 
Equation 2.1 and 2.2, see Figure D. 1 for the principle. The force and moment for the slaved node, 
with index A, is calculated from the forces in the master nodes, with index 1 to 5. (MSC Software 
Corporation 2012a) 
 

i

i
Ai FF   (2.1) 

2
ii

ii
Ai r

rMF  (2.2) 
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ir
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iM
iF

i

i

i

i

 node point togravity  ofcenter   wighted thefrom radius ... 
 nodeat factor   weighting... 

 nodeat moment ...
nodeatforce...

  where  

 

                  
 a) Force b) Moment 

Figure D. 1: Force distribution for RBE3 (MSC Software Corporation 2012a) 

 
 

D.2.1  Automated Script 
The automated script for RBE3 connecting the global and local model is implemented in 
HyperMesh 11.0 according to the steps below. RADIOSS 11.0 is used as solver and HyperView 
11.0 as post-processor. 
 

1. Download the script: rbe3_carpet_macro.tcl from the homepage of Altair (login is needed). 

2. Set up both the global and local model in the same file. Define properties, loads and 
boundary conditions. 

3. Create a component with the faces of the local model 
Click Tool > Faces > Comps in the Main Menu. Choose the local model and press Find 
faces. 

 

Figure D. 2: Find faces 

 
4. Delete the faces that are not to be connected with RBE3. In this case, the top and bottom of 

the local model. 

FA 

F1 

F2 

F3 

F4 

F5 

F1 

r1 
r2 

r3 

r4 

r5 

MA 

F2 

F3 

F4 

F5 
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Figure D. 3: Faces of the local model (turquoise) 

 
5. Create a component with the global elements closest to the local model. 

Click Tool > Organize > Collectors in the Main Menu. Choose the elements and 
destination component. 

6. Run the script 
Click File > Run > Tcl/Tk Scrip in the Menu Bar. Choose rbe3_carpet_macro.tcl 

    

Figure D. 4: Run Tcl-script 

 
7. The script asks for the coarse node in the Status Bar.  

Hide all components except the one with the elements closest to the local model, mark all 
inner nodes. Press proceed or the scroll button. 
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Figure D. 5: Select the loaded coarse node 

 
8. The script asks for the coarse elements in the Status Bar. 

Click Elements > By collector in the Main Menu. Choose the component with the elements 
closest to the local model. Press select > proceed 

9. The script asks for the fine mesh skin nodes in the Status Bar.  
Hide all components except the one with the faces of the local model, mark all nodes. Press 
proceed or the scroll button. 

10. The RBE3 elements are created in a new component called rbe_carpet. If it is not a Shell-
To-Solid connection it is important to edit the degrees of freedom. 
Click 1D > RBE3 > Update > DOF > Set individual in the Main Menu. Choose the 
elements to be edited and wanted degrees of freedom. Mark all nodes to be edited, press 
Update 

 
Figure D. 6: Update DOF 

 
11. Run the analysis 

 

D.2.2  Manual Method 
The manual method for RBE3 to connect the global and local model is implemented in HyperMesh 
11.0 according to the steps below. RADIOSS 11.0 is used as solver and HyperView 11.0 as post-
processor. 
 

1. Download the script: update_rbe3_weights.tcl from the homepage of Altair (login is 
needed). 
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2. Set up both the global and local model in the same file. Define properties, loads and 
boundary conditions. 

3. Define RBE3 elements with wanted settings for DOF and weight factors.  
Click 1D > RBE3 > Create. Chose dependent (slave) and independent (masters) nodes. 

 
Figure D. 7: Define RBE3 

 

4. Update the DOF if other settings than default is wanted. See step 10 in previous section 

5. Update the weight factors. This can be done manually in the same menu as for DOF or with 
a Tlc-script provided by Altair. The script is used here, start by running the script 
Click File > Run > Tcl/Tk Scrip in the Menu Bar. Choose update_rbe3_weights.tcl 

6. The script asks for the RBE3 elements to update in the status bar.  
Choose all RBE3 elements. Click Proceed. 

7. The script asks “Only update rbe3s attached to masses?” 
Click No (default), to update all elements or Yes to update only the RBE3 elements attached 
to mass elements  

8. Run the analysis. 

 

D.3 Glue 
Glue, used to connect the global and local model, is implemented in MSC Patran according to the 
steps below. Glue is only available in MSC Patran 2010 or later. 
 

1. Set up both the global and local model in the same file. Define properties, loads and 
boundary conditions. 

2. Create contact bodies 
Click Loads/BCs > Create > Contact > Deformable Body. Name the set and choose 2D for 
shell and 3D for solid. Click Select Application Region > FEM and choose the elements for 
the local respectively global model. 
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Figure D. 8: Create contact bodies 

 

3. Set up the analysis 
Click Analysis 

a) Choose MASTER as output format 
Click Solution Type > Solution Parameters > Results Output Format: Select 
MASTER/DBALL  
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Figure D. 9: Choose MASTER as output format 

 

b) Set up the contact tables for each load case 
Click Subcases > Subcase Parameters > Contact Table 
 

 

Figure D. 10: Set up the contact tables 

 
The choice of slave and master surface can have a significant impact on the accuracy 
of the result. If both surfaces are deformable, the master surface should be chosen as 
the surface with the coarser mesh. A rigid surface cannot act as a slave surface and is 
therefore always used as the master surface. This also means that the constraints 
between two rigid surfaces will be removed and replaced by a connector. (Abaqus 
2007) 
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For Shell-To-Solid: Define the contact table according to Figure D. 11. Mark 2nd->1st 
Contact Detection. In MSC Nastran, the default values of the tolerance region is 25 % 
of the thinnest shell thickness for shell elements or 5 % of the smallest element length 
for solid elements, defined normal to the contact area. Bias factor is default 0.9. 
 

For Shell-To-Shell: Define the contact table according to Figure D. 12. Mark 
Automatic Contact Detection and Retain moment (IGLUE). Click Options 
(COPTS/COPTM) and mark Ignore Thickness for both slave and master. It is 
important to choose a moment carrying connection (IGLUE) if the constraint is used 
between different dimensions, otherwise a joint will occur. 
 

 

Figure D. 11: Contact table for Shell-To-Solid contact 
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Figure D. 12: Contact table for Shell-To-Shell contact 

 
c) Set up output requests 

Click Subcases > Output Request : Select Contact results 

d) Choose type of contact  
 
For MSC Patran 2012: Click Solution Type > Solution Parameters > Contact 
Parameters > Contact Method: Choose Node to Segment for Shell-To-Shell 
respectively Segment-To-Segment for Shell-To-Solid or Solid-To-Solid. Click Contact 
Detection > Glue Options: choose Permanent Gluing (NLGLUE) 
 
For MSC Patran 2010: Open the .bdf-file and ad following under BCPARA, for Shell-
To-Solid (No editing is needed for Shell-To-Shell):  
METHOD   SEGSMALL   NLGLUE   1.. 

4. Run the analysis with scr=no 

 

D.4 DMIG with Mesh Refinement 
DMIG is implemented with mesh refinement in MSC Patran 2012 and MSC Nastran 2012. 
HyperMesh supports mesh refinement in a more automated way than MSC Patran, therefore is the 
global model with mesh refinement created in HyperMesh and then exported to MSC Patran. The 
workflow is described in the steps below. 
 

1. Create global model with mesh refinement in HyperMesh according to the steps described 
in section D.1. 

2. Export the model to MSC Patran 

3. Define properties, loads and boundary conditions in MSC Patran 
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4. Set up the analysis 
Click Analysis > Solution Type > Select ASET/QSET: Choose the defined ASET-nodes. 
Click Direct Text Input > File Management Section, mark FMS Write To Input Deck and 
write 
ASSIGN OUTPUT=’filename.op2’, UNIT=50, DELETE 
Click Direct Text Input >Case Control Section, mark Case Write To Input Deck and write 
EXTSEOUT(ASMBULK=AUTO, DMIGOP2=50, EXTID=10) 

 

Figure D. 13: Direct Text Input 

 
5. Run the analysis 

6. Create a local model, with boundary nodes to the global model with the same coordinates 
as for the global model. Define properties, loads and boundary conditions. All load cases 
has to be defined but if they are not action on the local model they can be empty. 

7. Set up the analysis 
Click Direct Text Input > File Management Section, mark FMS Write To Input Deck and 
write 
ASSIGN INTPUTT2=’filename.op2’, UNIT=50 
Click Direct Text Input >Bulk Data Section, mark BULK Write To Input Deck and write 
INCLUDE ‘filename.asm’ 

8. Run the analysis 

 

D.5 DMIG with RBE3 
DMIG is implemented with RBE3 in MSC Patran 2012 and MSC Nastran 2012 according to the 
steps below.  
 
In MSC Nastran, there are two different types of RBE-methods; linear and Lagrange method. When 
the linear method is used the RBE are not real elements, they are internally represented by a set of 
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multipoint constraints equations, see section 2.3.4. The Lagrange method uses real finite element 
where the stiffness matrix is computed for each RBE. (MSC Software Corporation 2012a)  
 
 

1. Create global model. Define properties, loads and boundary conditions. 

2. Define ASET-nodes for all the nodes on the boundary to the local model. 
Click Meshing > Create > DOF List > Define Terms: Choose all DOFs and boundary 
nodes 

 

Figure D. 14: Define ASET-nodes on the global model 

 
3. Create RBE3 elements on the boundary of the local model according to the manual method 

described in this thesis. Click Meshing > Create > MPC > RBE3. Choose all DOFs and the 
desired dependent and independent nodes. 

4. Follow the steps 5 to 9 in the section D.4 above. 
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